Legal Notice

Copyright © 2016 Veritas Technologies LLC. All rights reserved.

Veritas and the Veritas Logo are trademarks or registered trademarks of Veritas Technologies LLC or its affiliates in the U.S. and other countries. Other names may be trademarks of their respective owners.

This product may contain third party software for which Veritas is required to provide attribution to the third party ("Third Party Programs"). Some of the Third Party Programs are available under open source or free software licenses. The License Agreement accompanying the Software does not alter any rights or obligations you may have under those open source or free software licenses. Refer to the third party legal notices document accompanying this Veritas product or available at:

https://www.veritas.com/about/legal/license-agreements

The product described in this document is distributed under licenses restricting its use, copying, distribution, and decompilation/reverse engineering. No part of this document may be reproduced in any form by any means without prior written authorization of Veritas Technologies LLC and its licensors, if any.

THE DOCUMENTATION IS PROVIDED "AS IS" AND ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID. VERITAS TECHNOLOGIES LLC SHALL NOT BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, PERFORMANCE, OR USE OF THIS DOCUMENTATION. THE INFORMATION CONTAINED IN THIS DOCUMENTATION IS SUBJECT TO CHANGE WITHOUT NOTICE.

The Licensed Software and Documentation are deemed to be commercial computer software as defined in FAR 12.212 and subject to restricted rights as defined in FAR Section 52.227-19 "Commercial Computer Software - Restricted Rights" and DFARS 227.7202, et seq. "Commercial Computer Software and Commercial Computer Software Documentation," as applicable, and any successor regulations, whether delivered by Veritas as on premises or hosted services. Any use, modification, reproduction release, performance, display or disclosure of the Licensed Software and Documentation by the U.S. Government shall be solely in accordance with the terms of this Agreement.

Veritas Technologies LLC
500 E Middlefield Road
Mountain View, CA 94043
Technical Support

Technical Support maintains support centers globally. All support services will be delivered in accordance with your support agreement and the then-current enterprise technical support policies. For information about our support offerings and how to contact Technical Support, visit our website:

https://www.veritas.com/support

You can manage your Veritas account information at the following URL:

https://my.veritas.com

If you have questions regarding an existing support agreement, please email the support agreement administration team for your region as follows:

Worldwide (except Japan)  CustomerCare@veritas.com
Japan  CustomerCare_Japan@veritas.com

Documentation

The latest documentation is available on the Veritas website:

https://sort.veritas.com/documents

Documentation feedback

Your feedback is important to us. Suggest improvements or report errors or omissions to the documentation. Include the document title, document version, chapter title, and section title of the text on which you are reporting. Send feedback to:

NB.docs@veritas.com

You can also see documentation information or ask a question on the Veritas community site:

http://www.veritas.com/community/

Veritas Services and Operations Readiness Tools (SORT)

Veritas Services and Operations Readiness Tools (SORT) is a website that provides information and tools to automate and simplify certain time-consuming administrative tasks. Depending on the product, SORT helps you prepare for installations and upgrades, identify risks in your datacenters, and improve operational efficiency. To see what services and tools SORT provides for your product, see the data sheet:

Chapter 1  Introducing AdvancedDisk ................................................................. 7
   About the AdvancedDisk storage option .................................................. 7
Chapter 2  Licensing AdvancedDisk ............................................................... 9
   About the AdvancedDisk license ............................................................. 9
   Licensing AdvancedDisk .................................................................. 9
Chapter 3  Configuring AdvancedDisk .......................................................... 11
   Configuring the AdvancedDisk option .................................................. 12
   About AdvancedDisk file system requirements .................................... 13
   Configuring credentials for CIFS storage and disk storage units .......... 14
   About AdvancedDisk storage servers ............................................... 15
   About AdvancedDisk data movers ...................................................... 16
   About AdvancedDisk preferred or required read servers ................. 16
   About data encryption for AdvancedDisk storage ......................... 18
   About key management for encryption of NetBackup AdvancedDisk
       storage .................................................................................. 19
   Configuring key management for NetBackup AdvancedDisk storage
       encryption ................................................................................ 21
   Setting up the KMS database for NetBackup AdvancedDisk
       storage encryption ...................................................................... 21
   Creating a KMS key group for NetBackup AdvancedDisk storage
       encryption ............................................................................... 23
   Creating a KMS key for NetBackup AdvancedDisk storage
       encryption ............................................................................... 24
   Saving a record of the KMS key names for NetBackup
       AdvancedDisk storage encryption ............................................ 25
   Configuring an AdvancedDisk storage server .................................... 27
   AdvancedDisk storage server configuration options ...................... 38
   About AdvancedDisk disk pools ...................................................... 39
   Configuring a CIFS disk volume for AdvancedDisk encryption .......... 41
   Configuring an AdvancedDisk disk pool .......................................... 42
   NetBackup nbdevconfig command options for AdvancedDisk disk
       pools ...................................................................................... 51
Chapter 4 Managing AdvancedDisk

Managing AdvancedDisk storage servers .................................................. 72
  Viewing AdvancedDisk storage servers ........................................... 73
  Determining AdvancedDisk storage server state ................................ 73
  Viewing AdvancedDisk storage server attributes ............................... 73
  Removing AdvancedDisk storage server attributes ............................. 74
  Removing an AdvancedDisk storage server from disk pool access ........... 75
  Deleting an AdvancedDisk storage server ........................................ 75
Managing AdvancedDisk disk pools ....................................................... 76
  Viewing AdvancedDisk disk pools ................................................... 76
  About changing the AdvancedDisk disk pool size ............................. 76
  Adding volumes to an AdvancedDisk disk pool ................................. 77
  Changing AdvancedDisk disk pool properties .................................... 77
  Determining AdvancedDisk disk pool state ...................................... 79
  Changing AdvancedDisk disk pool state ......................................... 79
  Determining AdvancedDisk disk volume state .................................. 79
  Changing AdvancedDisk disk volume state ...................................... 80
  Merging AdvancedDisk disk pools .................................................. 81
  Removing a volume from an AdvancedDisk disk pool ......................... 81
  Inventorying a NetBackup disk pool .............................................. 82
  Deleting an AdvancedDisk disk pool ............................................. 83
About monitoring AdvancedDisk storage capacity and usage .................. 83
Monitoring NetBackup disk activity ................................................... 84
Viewing AdvancedDisk disk reports .................................................. 85
Displaying detailed AdvancedDisk storage usage information ................. 86
  NetBackup disk volume capacity and usage reference ....................... 87
Displaying KMS key information for AdvancedDisk encryption ................ 89
Chapter 5  Troubleshooting AdvancedDisk ........................................... 92
  About unified logging ........................................................................ 92
  About using the vxlogview command to view unified logs ............. 93
  Examples of using vxlogview to view unified logs ....................... 94
  About legacy logging ....................................................................... 95
  Creating NetBackup log file directories for AdvancedDisk .......... 97
NetBackup AdvancedDisk log files ................................................. 97
AdvancedDisk troubleshooting ....................................................... 99
Resolving an incorrect storage type problem ............................... 100

Index .................................................................................................. 102
Introducing AdvancedDisk

This chapter includes the following topics:

- About the AdvancedDisk storage option

About the AdvancedDisk storage option

The NetBackup AdvancedDisk storage option lets you use the disk storage that is exposed to NetBackup as a file system for backups. Storage can be direct attached storage (DAS), network attached storage (NAS), or storage area network (SAN) storage.

NetBackup requires exclusive access to the storage for capacity management and load balancing.

Table 1-1 describes some of the benefits of AdvancedDisk storage.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Benefit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Easy to deploy and use</td>
<td>NetBackup discovers the storage and uses NetBackup storage units and backup policies to use the storage.</td>
</tr>
<tr>
<td>Simplified growth</td>
<td>Lets you increase storage unit capacity by adding disks. Only add the capacity required, then update the NetBackup disk pools. Logical units of storage span physical boundaries, so you do not have to create new NetBackup storage units or change the backup policies.</td>
</tr>
<tr>
<td>Storage sharing</td>
<td>Multiple storage units can share a disk pool. Space is allocated dynamically as required. Automatic space allocation reduces the risk of backup failure.</td>
</tr>
</tbody>
</table>
Table 1-1  AdvancedDisk features and benefits (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Benefit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best fit selection</td>
<td>NetBackup predicts the size of the backup and selects the</td>
</tr>
<tr>
<td></td>
<td>storage on which the backup fits best. The goal is to avoid</td>
</tr>
<tr>
<td></td>
<td>out-of-space conditions and disk spanning.</td>
</tr>
<tr>
<td>Load balancing</td>
<td>Load balancing can occur at two levels, as follows:</td>
</tr>
<tr>
<td></td>
<td>• Storage servers. If you have more than one storage</td>
</tr>
<tr>
<td></td>
<td>server, NetBackup chooses the least busy media server for each backup.</td>
</tr>
<tr>
<td></td>
<td>Load balancing increases the performance and the success of backup</td>
</tr>
<tr>
<td></td>
<td>jobs.</td>
</tr>
<tr>
<td></td>
<td>• Storage unit groups. If you have more than one storage unit, you</td>
</tr>
<tr>
<td></td>
<td>can choose the storage unit group <strong>Load Balance</strong> option. If the</td>
</tr>
<tr>
<td></td>
<td>destination of each storage unit is a separate disk pool, NetBackup</td>
</tr>
<tr>
<td></td>
<td>chooses the least busy disk pool.</td>
</tr>
<tr>
<td>Intelligent capacity</td>
<td>NetBackup expires backup images when the storage that is</td>
</tr>
<tr>
<td>management</td>
<td>consumed reaches a threshold. The disk pool high water mark applies</td>
</tr>
<tr>
<td></td>
<td>to both individual disk volumes and to disk pools.</td>
</tr>
<tr>
<td>Storage lifecycle</td>
<td>You can classify data based on its importance and manage</td>
</tr>
<tr>
<td></td>
<td>it differently throughout each stage of its life. After it has been</td>
</tr>
<tr>
<td></td>
<td>duplicated, data can be selectively expired based on the</td>
</tr>
<tr>
<td></td>
<td>relative importance to the business. You can ensure that</td>
</tr>
<tr>
<td></td>
<td>important backups are available for rapid restore for longer</td>
</tr>
<tr>
<td></td>
<td>periods, ensuring your recovery time objectives.</td>
</tr>
</tbody>
</table>

Figure 1-1 shows a media server and attached disks.

Figure 1-1  AdvancedDisk storage example

![AdvancedDisk storage example diagram](image-url)
Licensing AdvancedDisk

This chapter includes the following topics:

- About the AdvancedDisk license
- Licensing AdvancedDisk

About the AdvancedDisk license

AdvancedDisk is a feature that is licensed separately from base NetBackup. See “Licensing AdvancedDisk” on page 9.

If you remove the license key or if it expires, the following restrictions apply:

- You cannot create the disk pools or the storage units that reference AdvancedDisk disk pools.
- NetBackup jobs that attempt to use the disk pools or the storage units that are based on disk pools fail. The error message indicates that the feature is not licensed.

NetBackup does not delete the disk pools or the storage units that reference the disk pools. You can use them again if you enter a valid license.

Licensing AdvancedDisk

No special installation is required for the NetBackup components of AdvancedDisk. However, you must enter a license. If you installed the license when you installed or upgraded NetBackup, you do not need to perform this procedure.

Enter the license on the NetBackup master server. The following procedure describes how to use the NetBackup Administration Console to enter the license.
To license AdvancedDisk

1. On the Help menu of the NetBackup Administration Console on the NetBackup master server, select License Keys.
2. In the NetBackup License Keys dialog box, click New.
3. In the Add a New License Key dialog box, enter the license key and click Add or OK.
4. In the NetBackup License Key dialog box, click Close.
5. Restart all the NetBackup services and daemons.
This chapter includes the following topics:

- Configuring the AdvancedDisk option
- About AdvancedDisk file system requirements
- Configuring credentials for CIFS storage and disk storage units
- About AdvancedDisk storage servers
- About AdvancedDisk data movers
- About AdvancedDisk preferred or required read servers
- About data encryption for AdvancedDisk storage
- About key management for encryption of NetBackup AdvancedDisk storage
- Configuring key management for NetBackup AdvancedDisk storage encryption
- Configuring an AdvancedDisk storage server
- About AdvancedDisk disk pools
- Configuring a CIFS disk volume for AdvancedDisk encryption
- Configuring an AdvancedDisk disk pool
- Configuring an AdvancedDisk storage unit
- About storage lifecycle policies
- Creating a storage lifecycle policy
- Creating a backup policy
- Resilient Network properties
Specifying resilient connections

Configuring the AdvancedDisk option

This section provides an overview of how to configure the NetBackup AdvancedDisk option.

Table 3-1 describes the configuration tasks.

To configure a base NetBackup environment, see the NetBackup Administrator's Guide, Volume I:

http://www.veritas.com/docs/DOC5332

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Learn about file system requirements</td>
<td>See “About AdvancedDisk file system requirements” on page 13.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Learn about storage servers, data movers, and disk pools</td>
<td>See &quot;About AdvancedDisk storage servers&quot; on page 15.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About AdvancedDisk data movers” on page 16.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About AdvancedDisk disk pools” on page 39.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Optionally, configure the Key Management Service</td>
<td>The Key Management Service is required if you use data encryption for the AdvancedDisk storage.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About data encryption for AdvancedDisk storage” on page 18.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About key management for encryption of NetBackup AdvancedDisk storage” on page 19.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Configuring key management for NetBackup AdvancedDisk storage encryption” on page 21.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Configure a storage server</td>
<td>See “Configuring an AdvancedDisk storage server” on page 27.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Optionally, configure CIFS disk volumes</td>
<td>For the AdvancedDisk_crypt disk type, you must configure CIFS volumes before you can add them to the disk pool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Configuring a CIFS disk volume for AdvancedDisk encryption” on page 41.</td>
</tr>
</tbody>
</table>
### About AdvancedDisk file system requirements

AdvancedDisk can read and write any nonshared file system that NetBackup supports. However, AdvancedDisk is subject to any operating system or file system requirements or limitations. Requirements and limitations may exist beyond those mentioned in this topic.

For supported file systems, see the NetBackup operating system compatibility list at the Veritas Support website, as follows:


The following are additional requirements and limitations for file systems:

<table>
<thead>
<tr>
<th>CIFS</th>
<th>Windows Common Internet File System (CIFS) requirements:</th>
</tr>
</thead>
<tbody>
<tr>
<td>■</td>
<td>Ensure that the Windows disk shares are configured to reconnect on login.</td>
</tr>
<tr>
<td>■</td>
<td>Networked mapped devices are not visible to Windows services; therefore, NetBackup cannot discover CIFS disk volumes. You must use the Windows Universal Naming Convention (UNC) to specify the CIFS volumes that you want to use for AdvancedDisk disk pools.</td>
</tr>
<tr>
<td>■</td>
<td>You must configure two Windows services to use the same credentials. See “Configuring credentials for CIFS storage and disk storage units” on page 14.</td>
</tr>
<tr>
<td>■</td>
<td>You cannot delete a disk pool that is created by specifying volumes (such as for CIFS volumes). The disk pool exists until you delete its storage server.</td>
</tr>
</tbody>
</table>
NFS Network File System (NFS) requirements:
- You must use manual mount points. Automatic mount and unmount can change mount points, which may cause disk resources to be unavailable.
- The NFS server that exports the mount points must be configured to allow root access to the file systems.
- NFS uses a file system paradigm to manage objects. Therefore, carefully choose the volumes to include in the disk pool.
  For example, NetBackup does not filter out common file system mount points, such as / and /usr on UNIX and Linux systems. You should not use those mount points for storage.
- Veritas recommends that you do not span backup images across NFS volumes in an AdvancedDisk disk pool. File system full conditions cannot be detected adequately. Therefore, a disk pool based on NFS volumes should be comprised of only one volume.

ZFS Veritas recommends that you do not span backup images across ZFS volumes in an AdvancedDisk disk pool. File system full conditions cannot be detected adequately. Therefore, a disk pool based on ZFS volumes should be comprised of only one volume.

Disk pool configuration may affect how you configure your file systems.
See “Configuring an AdvancedDisk disk pool” on page 42.

Configuring credentials for CIFS storage and disk storage units

For Common Internet File System (CIFS) storage with AdvancedDisk and BasicDisk storage units, the following two NetBackup services on Windows computers require matching account credentials:

NetBackup Client Service
- The NetBackup Client Service is either bpcd.exe or bpinetd.exe, depending on NetBackup release level. Regardless of the binary file name, the service requires the credentials.

NetBackup Remote Manager and Monitor Service
- The NetBackup Remote Manager and Monitor Service binary file name is nbrmms.exe.

The following items describe the requirements for the account and credentials:
- Both of the services must run under the same Windows user account.
- The account must be the same account that the Windows operating system uses for read and write access to the CIFS share.
Configure the account and the credentials on the media server or media servers that have a file system mount on the CIFS storage. Then, configure Windows so that the two aforementioned services use that account.

If account credentials are not configured properly, NetBackup marks all CIFS AdvancedDisk and BasicDisk storage units that use the UNC naming convention as DOWN.

To configure service credentials for CIFS storage and disk storage units

- In Windows, configure both the NetBackup Client Service and the NetBackup Remote Manager and Monitor Service so they meet the credential requirements. Those requirements are described previously in this document.

  See your Windows operating system documentation for the procedures. How to configure Windows is beyond the scope of the NetBackup documentation.

About AdvancedDisk storage servers

A storage server is a NetBackup media server that mounts the disk storage and writes data to and reads data from the disk storage.

For AdvancedDisk, NetBackup media servers function as both storage servers and data movers.

See “About AdvancedDisk data movers” on page 16.

Multiple storage servers can exist. The storage servers share the storage equally.

If you configure more than one storage server, be aware of the following:

- Each media server must mount the file systems of all the disk volumes within a disk pool.

- The mount points must be the same on each media server.
  
  NetBackup does not validate mount points, so you must ensure that the mount points are the same for each media server. You also must ensure that the mount points are valid.

- To obtain a consolidated list of disk volumes, NetBackup queries every media server. For large sets of servers, queries may affect performance.

- Disk volume status is monitored on a single media server. Which server monitors the status can change. Therefore, a change in disk volume availability on one media server may not be reflected in the disk volume status NetBackup reports.

An AdvancedDisk storage server can have the attributes that can help you manage your restore and your duplication traffic.

See “About AdvancedDisk preferred or required read servers” on page 16.
Storage servers are either AdvancedDisk type or AdvancedDisk_crypt type. See “About data encryption for AdvancedDisk storage” on page 18. Whether or not you want to specify storage server attributes or use encryption determines how you configure the storage servers. See “Configuring an AdvancedDisk storage server” on page 27.

About AdvancedDisk data movers

A data mover transfers data from primary storage (a NetBackup client) to secondary storage during backups. It also can move data back to primary storage during restores and from secondary storage to tertiary storage during duplication.

You do not configure data movers separately. For AdvancedDisk, NetBackup media servers function as both storage servers and data movers. Data movers are configured when you configure storage servers.

About AdvancedDisk preferred or required read servers

When you configure a storage server, you can specify that you want it to be preferred or required for restore jobs. You also can specify whether a server should be required for the read side of duplication jobs. These attributes can help manage the restore and the duplication traffic.

The following are the requirements to configure encryption:

- You must use the nbdevconfig command to configure the storage servers and the disk pools.
- You must use the -setattribute option when you configure the storage servers and the disk pools.
  
  Table 3-2 describes the possible arguments for the -setattribute option.

See “Configuring an AdvancedDisk storage server” on page 27.
Table 3-2  Preferred or required read server descriptions

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
</table>
| **PrefRestore** | The server is preferred for the read side of restore operations. You can configure more than one server as preferred for restore.  
If you configure preferred for restore but not required for restore, NetBackup considers preferred storage servers for jobs first. If none are available, NetBackup considers any configured storage server.  
Normal NetBackup load balancing occurs among all storage servers marked PrefRestore. |
| **ReqRestore** | The server is required for the read side of restore operations. You can configure more than one server as required for restore.  
If you configure required servers for restore but not preferred servers, jobs queue until a required server is available to execute the job. Other servers are never considered for restore jobs. Normal NetBackup rules for job retry apply.  
If you configure both preferred and required storage servers and a required server is not available, NetBackup considers preferred servers for jobs. If none are available, jobs queue until a required or preferred server is available. Other servers are never considered for restore jobs.  
Normal NetBackup load balancing occurs for all required servers. Load balancing does not occur between the required and preferred servers. |
| **ReqDuplicate** | The server is required for the read side of duplication operations. You can configure more than one server as required for duplication.  
If any server is configured as required for duplication, NetBackup considers only required for duplication servers for jobs. If a required server is unavailable, jobs queue until a required server is available to execute the job. Normal NetBackup rules for job retry apply.  
Required for duplication also applies to storage server allocation for synthetic backup operations. |

Only the media servers that are configured in the storage unit are considered for jobs. Therefore, if you configure a subset of the disk pool media servers in a storage unit, NetBackup selects from those servers only.

If you use the preferred or required restore or duplication attributes for a storage server, the following may occur:

- A restore operation uses a storage server that does not have a **PrefRestore** or **ReqRestore** attribute. Reasons may be as follows:
About data encryption for AdvancedDisk storage

You can encrypt your data on the storage that you use for AdvancedDisk. The following are the requirements to configure encryption:

- You must configure the NetBackup Key Management Service so that NetBackup can manage the encryption keys. NetBackup uses KMS to manage encryption keys. You must use NetBackup commands to configure both the Key Management Service and the AdvancedDisk storage server. See “About key management for encryption of NetBackup AdvancedDisk storage” on page 19.

- You must use the `nbdevconfig` command to configure the storage servers and the disk pools.

- You must use the `AdvancedDisk_crypt` type when you configure the storage servers and the disk pools.
After you configure KMS and AdvancedDisk_crypt storage servers and disk pools, NetBackup uses encryption for backup jobs to those disk pools.

**Note:** NetBackup does not span volumes for the AdvancedDisk_crypt type of disk pool.

See “About AdvancedDisk disk pools” on page 39.

AdvancedDisk encryption is supported on a subset of operating systems that NetBackup supports. For supported systems, see the NetBackup compatibility lists on the NetBackup support landing page.

http://www.netbackup.com/compatibility

More information about data-at-rest encryption and security is available.

See the *NetBackup Security and Encryption Guide*:

http://www.veritas.com/docs/DOC5332

---

### About key management for encryption of NetBackup AdvancedDisk storage

NetBackup uses the Key Management Service (KMS) to manage the keys for the data encryption for disk storage. KMS is a NetBackup master server-based symmetric key management service. The service runs on the NetBackup master server. An additional license is not required to use the KMS functionality.

NetBackup uses KMS to manage the encryption keys for AdvancedDisk storage.

See “About data encryption for AdvancedDisk storage” on page 18.

The following table describes the encryption keys that are required for the KMS database.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Master Key</td>
<td>The Host Master Key protects the key database. The Host Master Key requires a pass phrase and an ID. KMS uses the pass phrase to generate the key.</td>
</tr>
<tr>
<td>Key Protection Key</td>
<td>A Key Protection Key protects individual records in the key database. The Key Protection Key requires a pass phrase and an ID. KMS uses the pass phrase to generate the key.</td>
</tr>
</tbody>
</table>
The following table describes the encryption keys that are required for each storage server and volume combination.

### Table 3-4  Encryption keys required for each storage server and volume combination

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
</table>
| A key group       | A key group key protects the key group. Each storage server and volume combination requires a key group, and each key group key requires a pass phrase. The key group name must use the format for the storage type that is described as follows: For AdvancedDisk storage, the format depends on the operating system type that hosts the storage, as follows:  
  - **UNIX storage:** `storage_server_name:volume_name` 
    The following items describe the requirements for the key group name components for AdvancedDisk storage on UNIX:  
    - `storage_server_name`: You must use the same name that you use for the storage server. The name can be a fully-qualified domain name or a short name, but it must be the same as the storage server.  
    - The colon (:) is required after the `storage_server_name`.  
    - `volume_name`: Use the last directory name in the storage path for the `volume_name`. For example, use `backups` if the storage path is `/mnt/disk/backups`.  
  - **Windows storage:** `storage_server_name:` 
    The following items describe the requirements for the key group name components for AdvancedDisk storage on Windows:  
    - `storage_server_name`: You must use the same name that you use for the storage server. The name can be a fully-qualified domain name or a short name, but it must be the same as the storage server.  
    - The colon (:) is required after the `storage_server_name`.  
| A key record       | Each key group that you create requires a key record. A key record stores the actual key that protects the data for the storage server and volume.                                                                                                                                                                                                                       |

See “Configuring key management for NetBackup AdvancedDisk storage encryption” on page 21.

More information about KMS is available in the *NetBackup Security and Encryption Guide*:

http://www.veritas.com/docs/DOC5332
Configuring key management for NetBackup AdvancedDisk storage encryption

For AdvancedDisk storage, encryption is optional. If you do not use encryption, you do not have to configure key management. To use encryption, you must first configure key management by using NetBackup commands. See Table 3-5.

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Learn about NetBackup key management</td>
<td>See “About key management for encryption of NetBackup AdvancedDisk storage” on page 19.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Set up the KMS database</td>
<td>See “Setting up the KMS database for NetBackup AdvancedDisk storage encryption” on page 21.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Create the key groups</td>
<td>Each storage server and volume combination requires a key group. Each key group requires a key record. The key record contains the encryption key. See &quot;Creating a KMS key for NetBackup AdvancedDisk storage encryption&quot; on page 23.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Create the key records</td>
<td>The record of the key names lets you recreate the keys if they are lost. See &quot;Creating a KMS key for NetBackup AdvancedDisk storage encryption&quot; on page 24.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Save a record of the key names</td>
<td>The record of the key names lets you recreate the keys if they are lost. See &quot;Saving a record of the KMS key names for NetBackup AdvancedDisk storage encryption&quot; on page 25.</td>
</tr>
</tbody>
</table>

Setting up the KMS database for NetBackup AdvancedDisk storage encryption

Setting up the KMS database is the first task in the process of configuring the NetBackup Key Management Service by using NetBackup commands.

See “Configuring key management for NetBackup AdvancedDisk storage encryption” on page 21.
To set up the KMS database

1. On the NetBackup master server, create the KMS database by running the `nbkms` command with the `-createemptydb` option, as follows:
   - UNIX: `/usr/openv/netbackup/bin/nbkms -createemptydb`
   - Windows: `install_path\Veritas\NetBackup\bin\nbkms.exe -createemptydb`

   The following prompt appears:
   
   Enter the Host Master Key (HMK) passphrase (or hit ENTER to use a randomly generated HMK). The passphrase will not be displayed on the screen.
   Enter passphrase :

2. Enter a pass phrase for the host master key (HMK) or press Enter to create a randomly generated key.

   After you enter the Host Master Key pass phrase, the following prompt appears:
   
   An ID will be associated with the Host Master Key (HMK) just created. The ID will assist you in determining the HMK associated with any key store.
   Enter HMK ID :

3. Enter an ID for the HMK. This ID can be anything descriptive that you want to use to identify the HMK.

   After you enter the Host Master Key ID, the following prompt appears:
   
   Enter the Key Protection Key (KPK) passphrase (or hit ENTER to use a randomly generated KPK). The passphrase will not be displayed on the screen.
   Enter passphrase :

4. Enter a pass phrase for the Key Protection Key or press Enter to create a randomly generated key.

   After you enter the Key Protection Key pass phrase, the following prompt appears:
   
   An ID will be associated with the Key Protection Key (KPK) just created. The ID will assist you in determining the KPK associated with any key store.
   Enter KPK ID :
Enter an ID for the KPK. The ID can be anything descriptive that you want to use to identify the KPK.

Start the NetBackup Key Management Service on the master server. You can do so in the Activity Monitor of the NetBackup Administration Console.

After you start the service, the initial database setup is complete.

After you set up the database, create key groups for the volumes in the disk pool.

See “Creating a KMS key group for NetBackup AdvancedDisk storage encryption” on page 23.

Creating a KMS key group for NetBackup AdvancedDisk storage encryption

Creating a KMS key group is the second task in the process of configuring the NetBackup Key Management Service manually.

See “Configuring key management for NetBackup AdvancedDisk storage encryption” on page 21.

A key group is a container for key records. Each storage server and volume combination requires a key group in the following format:

- UNIX storage:  storage_server_name:volume_name
- Windows storage:  storage_server_name:

To create a KMS key group

1 On the NetBackup master server, create a key group by using the nbkmsutil command and the -createkg option. The format of the command depends on the operating system of the host or hosts to which the storage is attached, as follows:

Storage on UNIX:

/usr/openv/netbackup/bin/admincmd/nbkmsutil -createkg -kgname storage_server_name:volume_name

Storage on Windows:

install_path\Veritas\NetBackup\bin\admincmd\nbkmsutil -createkg -kgname storage_server_name:

The following is the criteria for the key group name:

- For the storage_server_name, you must use the same name that you use for the storage server. The name can be a fully-qualified domain name or a short name, but it must be the same as the storage server.
The colon (:) is required after the `storage_server_name`.

For the `volume_name` on UNIX host storage, specify the name of the last directory in the storage path. For example, use `backups` if the storage path is `/mnt/disk/backups`. Storage hosted on Windows servers does not require a `volume_name`.

After you create the key groups, create a key record for each group. See "Creating a KMS key for NetBackup AdvancedDisk storage encryption" on page 24.

Creating a KMS key for NetBackup AdvancedDisk storage encryption

Creating a KMS key is the third and the final task in the process of configuring the NetBackup Key Management Service manually.


Each key group requires at least one `key record`. The key record contains the encryption key itself and information about the key. The key is used to encrypt and decrypt data.

**Note:** If you create more than one key for a key group, only the last key remains active.
To create a KMS key

1 On the NetBackup master server, create a key record by using the `nbkmsutil` command and the `-createkey` option.

   UNIX: `/usr/openv/netbackup/bin/admincmd/nbkmsutil -createkey -keyname keyname -kgname key_group_name -activate`

   Windows: `install_path\Veritas\NetBackup\bin\admincmd\nbkmsutil -createkey -keyname keyname -kgname key_group_name -activate`

   Use the key group name that you configured when you created the key group.

   See “Creating a KMS key group for NetBackup AdvancedDisk storage encryption” on page 23.

   You are prompted to enter a pass phrase:

   Enter a passphrase:

2 Enter and then re-enter a pass phrase; this pass phrase should differ from any pass phrases that you entered already.

3 Save a record of the pass phrase.

   See “Saving a record of the KMS key names for NetBackup AdvancedDisk storage encryption” on page 25.

Saving a record of the KMS key names for NetBackup AdvancedDisk storage encryption

   Veritas recommends that you save a record of the encryption key names and tags. The key tag is necessary if you need to recover or recreate the keys.

   See “Configuring key management for NetBackup AdvancedDisk storage encryption” on page 21.
To save a record of the key names

1 To determine the key group names, use the following command on the master server:

**UNIX:** /usr/openv/netbackup/bin/admincmd/nbkmsutil -listkgs

**Windows:** install_path\Program
Files\Veritas\NetBackup\bin\admincmd\nbkmsutil.exe -listkgs

The following is example output:

<table>
<thead>
<tr>
<th>Key Group Name</th>
<th>UX_Host.example.com:backups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported Cipher</td>
<td>AES_256</td>
</tr>
<tr>
<td>Number of Keys</td>
<td>1</td>
</tr>
<tr>
<td>Has Active Key</td>
<td>Yes</td>
</tr>
<tr>
<td>Creation Time</td>
<td>Tues Oct 01 01:00:00 2013</td>
</tr>
<tr>
<td>Last Modification Time</td>
<td>Tues Oct 01 01:00:00 2013</td>
</tr>
<tr>
<td>Description</td>
<td>-</td>
</tr>
<tr>
<td>FIPS Approved Key</td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Key Group Name</th>
<th>Win_Host.example.com:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported Cipher</td>
<td>AES_256</td>
</tr>
<tr>
<td>Number of Keys</td>
<td>1</td>
</tr>
<tr>
<td>Has Active Key</td>
<td>Yes</td>
</tr>
<tr>
<td>Creation Time</td>
<td>Tues Oct 01 01:05:00 2013</td>
</tr>
<tr>
<td>Last Modification Time</td>
<td>Tues Oct 01 01:05:00 2013</td>
</tr>
<tr>
<td>Description</td>
<td>-</td>
</tr>
<tr>
<td>FIPS Approved Key</td>
<td>Yes</td>
</tr>
</tbody>
</table>
2 For each key group, write all of the keys that belong to the group to a file. Run the command on the master server. The following is the command syntax:

**UNIX:**
```
/usr/openv/netbackup/bin/admincmd/nbkmsutil -listkeys -kname key_group_name > filename.txt
```

**Windows:**
```
install_path\Program Files\Veritas\NetBackup\bin\admincmd\nbkmsutil.exe -listkeys -kname key_group_name > filename.txt
```

The following is example output:
```
nbkmsutil.exe -listkeys -kname UX_Host.example.com:backups > encrypt_keys_UX_Host.example.com_backups.txt
```

<table>
<thead>
<tr>
<th>Key Group Name</th>
<th>UX_Host.example.com:backups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported Cipher</td>
<td>AES_256</td>
</tr>
<tr>
<td>Number of Keys</td>
<td>1</td>
</tr>
<tr>
<td>Has Active Key</td>
<td>Yes</td>
</tr>
<tr>
<td>Creation Time</td>
<td>Tues Oct 01 01:00:00 2013</td>
</tr>
<tr>
<td>Last Modification Time</td>
<td>Tues Oct 01 01:00:00 2013</td>
</tr>
<tr>
<td>Description</td>
<td>-</td>
</tr>
<tr>
<td>FIPS Approved Key</td>
<td>Yes</td>
</tr>
</tbody>
</table>

| Key Tag                 | 867d710aa7f4c64dcd2cc3...cde0c831c1812c510acd05 |
| Key Name                | AdvDisk_Key                  |
| Current State           | ACTIVE                       |
| Creation Time           | Tues Oct 01 01:05:00 2013    |
| Last Modification Time  | Tues Oct 01 01:05:00 2013    |
| Description             | -                            |
| FIPS Approved Key       | Yes                          |

Number of Keys: 1

3 Include in the file the pass phrase that you used to create the key record.

4 Store the file in a secure location.

## Configuring an AdvancedDisk storage server

Configure in this context means to configure as a storage server a NetBackup media server that can mount the storage.

See “About AdvancedDisk storage servers” on page 15.
How you configure an AdvancedDisk storage server depends on several factors, as follows:

**Encrypted storage**

If you want to encrypt the storage, you must use the NetBackup `nbdevconfig` command.

For the `AdvancedDisk_crypt` type of storage server, you must specify the `-st` option with a value of 5.

See “About data encryption for AdvancedDisk storage” on page 18.

See “To configure an AdvancedDisk storage server by using the command line” on page 29.

**Storage server attributes**

If you want to specify preferred or required attributes for the storage server, you must use the NetBackup `nbdevconfig` command.

See “About AdvancedDisk preferred or required read servers” on page 16.

See “To configure an AdvancedDisk storage server by using the command line” on page 29.

**No encryption or attributes**

Veritas recommends that you use the Storage Server Configuration Wizard to configure the `AdvancedDisk` type of storage server.

See “To configure an AdvancedDisk storage server by using the wizard” on page 29.

You can configure multiple storage servers for the same storage. Doing so provides load balancing and redundancy in case of a storage server failure. The following procedures explain how to configure multiple storage servers.

When you configure an AdvancedDisk storage server, it also is configured as a data mover.

See “About AdvancedDisk data movers” on page 16.
To configure an AdvancedDisk storage server by using the command line

1 Run the following command on the NetBackup master server or the media server:

**UNIX:**
```
/usr/openv/netbackup/bin/admincmd/nbdevconfig -creatests
-storage_server hostname -stype server_type -st 5 -media_server hostname [-setattribute attribute]
```

**Windows:**
```
install_path\NetBackup\bin\admincmd\nbdevconfig -creatests
-storage_server hostname -stype server_type -st 5 -media_server hostname [-setattribute attribute]
```

The arguments for the command options are in a different topic. The arguments include those for encryption, for attributes, and so on.

See “AdvancedDisk storage server configuration options” on page 38.

2 To verify that the storage server was configured correctly, run the following command:

**UNIX:**
```
/usr/openv/netbackup/bin/admincmd/nbdevquery -liststs -u
```

**Windows:**
```
install_path\NetBackup\bin\admincmd\nbdevquery -liststs -u
```

The following is an excerpt of the command output that shows the proper storage type for AdvancedDisk (Formatted Disk, Direct Attached):

```
Storage Server : AdvDiskServer.example.com
Storage Server Type : AdvancedDisk_crypt
Storage Type : Formatted Disk, Direct Attached
State : UP
```

3 After the storage server is created, you can do the following.

- To configure another storage server, go to step 1 and then repeat the steps in this procedure.
- If you have finished configuring storage servers, configure a disk pool. See “Configuring an AdvancedDisk disk pool” on page 42.

To configure an AdvancedDisk storage server by using the wizard

1 In the **NetBackup Administration Console**, select either **NetBackup Management** or **Media and Device Management**.

2 In the right pane, click **Configure Disk Storage Servers**.
3 On the **Welcome** panel, the types of storage servers that you can configure depend on the options for which you are licensed, as follows:

Select **AdvancedDisk** and then click **Next**. The behavior depends on whether you have separate media servers in your environment, as follows:

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A master server but no media servers</td>
<td><strong>Storage Server Configuration Summary</strong> panel appears.</td>
</tr>
<tr>
<td></td>
<td>Go to step 5.</td>
</tr>
<tr>
<td>Media servers are installed</td>
<td>The <strong>Add Storage Server</strong> panel appears.</td>
</tr>
<tr>
<td></td>
<td>Continue to step 4.</td>
</tr>
</tbody>
</table>
4 On the **Add Storage Server** panel, select the media server that you want to configure as an AdvancedDisk storage server from the **Media server** drop-down list. Then, click **Next**.

The following is an example of the wizard panel:

![Storage Server Configuration Wizard](image)

The **Storage Server Configuration Summary** panel appears.
5 On the **Storage Server Configuration Summary** panel, verify the selections. If OK, click **Next** to configure the storage server.

The following is an example of the wizard panel:

![Storage Server Configuration Wizard](image)

The **Storage Server Configuration Status** panel appears.
6 The **Storage Server Configuration Status** wizard panel describes the status of the operation, as follows:

![Storage Server Configuration Status](image)

After the storage server is created, you can do the following:

<table>
<thead>
<tr>
<th>Configure another storage server</th>
<th>Configure a disk pool</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Click Close</strong> and then repeat the steps in this procedure. Configure another storage server if you want to configure multiple AdvancedDisk storage servers for the storage that is allocated for the disk pool. When you configure the final storage server, then continue and create the disk pool.</td>
<td>Ensure that <strong>Create a disk pool using the storage server that you have just created</strong> is selected and then click <strong>Next</strong>. Configure a disk pool if you have finished configuring the storage servers that can access the disk pool. Continue with the next step.</td>
</tr>
</tbody>
</table>
The **Volume Selection** panel displays the volumes available on the storage server. If you selected more than one storage server, volumes that are common to all of them appear.

The following is an example of the wizard panel:

To specify a Common Internet File System (CIFS) disk volume, click **Add New Volume**. In the **Add New Volume** dialog box, enter the Windows Universal Naming Convention (UNC) pathname of the CIFS volume and then click **Validate and Add**.

Select the volumes to use for the disk pool. NetBackup does not filter out common file system mount points, such as `/` and `/usr`. Therefore, carefully choose the volumes to include in a disk pool.
See “About AdvancedDisk file system requirements” on page 13.

Click **Next**. The **Additional Disk Pool Information** wizard panel appears.

8 On the **Additional Disk Pool Information** panel, enter the values for the disk pool and then click **Next**.

See “**AdvancedDisk disk pool properties**” on page 53.

The following is an example of the wizard panel:

The **Summary** wizard panel appears after you click **Next**.
9 On the **Summary** panel, verify the selections. If OK, click **Next**.

The following is an example of the wizard panel:

![Storage Server Configuration Wizard](image)

The **Status** wizard panel appears after you click **Next**.
10 On the **Status** panel, monitor the progress of the operation.

The following is an example of the wizard panel:

![Storage Server Configuration Wizard](image)

After the disk pool is created, you can do the following:

- **Configure a storage unit**
  
  Ensure that **Create a storage unit using the disk pool that you have just created** is selected and then click **Next**. The **Storage Unit Creation** wizard panel appears. Continue to the next step.

- **Exit**
  
  Click **Close**.

  You can configure one or more storage units later.

  See “Configuring an AdvancedDisk disk pool” on page 42.
11 Enter the appropriate information for the storage unit. The following is an example of the wizard panel:

![Storage Server Configuration Wizard](image)

See “AdvancedDisk storage unit properties” on page 57. Click Next to create the storage unit.

12 After NetBackup configures the storage unit, the Finished panel appears. Click Finish to exit from the wizard.

AdvancedDisk storage server configuration options

The following are the nbdevconfig command options that are used to configure storage servers.
### Options to configure AdvancedDisk storage server

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-storage_server</code></td>
<td>The name of the NetBackup media server that has a file system mount on the storage.</td>
</tr>
<tr>
<td><code>-stype server_type</code></td>
<td>For AdvancedDisk with encryption, use <code>AdvancedDisk_crypt</code>, otherwise use <code>AdvancedDisk</code>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you specify <code>AdvancedDisk_crypt</code> as the <code>-stype</code>, you must specify an <code>-st</code> value of 5 on the command line.</td>
</tr>
<tr>
<td><code>-st storage_type</code></td>
<td>A numeric value that specifies the storage server properties. For AdvancedDisk, the default value is 5 (direct attached, formatted disk).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For an <code>AdvancedDisk_crypt</code> <code>-stype</code>, you must specify <code>-st 5</code> on the command line.</td>
</tr>
<tr>
<td><code>-media_server</code></td>
<td>Use the same name as the storage server name.</td>
</tr>
<tr>
<td><code>-setattribute</code></td>
<td>An attribute to apply to the storage server for the read side of restore or duplication operations. The following are the attributes:</td>
</tr>
<tr>
<td></td>
<td>■ PrefRestore. The storage server is preferred for the read side of restore operations. More than one storage server can have the PrefRestore attribute.</td>
</tr>
<tr>
<td></td>
<td>■ ReqRestore. The storage server is required for the read side of restore operations. More than one storage server can have the ReqRestore attribute.</td>
</tr>
<tr>
<td></td>
<td>■ ReqDuplicate. The storage server is required for the read side of duplication operations. More than one storage server can have the ReqDuplicate attribute.</td>
</tr>
<tr>
<td></td>
<td>See “About AdvancedDisk preferred or required read servers” on page 16.</td>
</tr>
</tbody>
</table>

### About AdvancedDisk disk pools

A disk pool represents disk volumes on the underlying disk storage. NetBackup aggregates the disk volumes into pools of storage you can use for backups. A disk pool is the storage destination of a NetBackup storage unit.

Disk pools are either `AdvancedDisk` type or `AdvancedDisk_crypt` type.

See “About data encryption for AdvancedDisk storage” on page 18.

For the `AdvancedDisk_crypt` disk type on CIFS storage, you must configure the disk volumes before you configure the disk pool.

See “Configuring a CIFS disk volume for AdvancedDisk encryption” on page 41.

See “Configuring an AdvancedDisk disk pool” on page 42.
Veritas recommends that disk pool and disk volume names be unique across your enterprise.

The following are disk pool and volume considerations for AdvancedDisk storage:

**Capacity management**

If an AdvancedDisk disk pool is a storage destination in a storage lifecycle policy, NetBackup capacity management applies. If you share the volumes in an AdvancedDisk disk pool with other users, NetBackup cannot manage disk pool capacity or storage lifecycle policies correctly.

**Volume selection**

NetBackup selects disk volumes based on available capacity and predicted size of the backup. NetBackup tries to write backup data to a single volume.

**Disk spanning**

If necessary, backup images span disk volumes in a disk pool. (Exception: NetBackup does not span volumes for the AdvancedDisk_crypt type of disk pool.) Backup images do not span across multiple disk pools.

To reduce disk spanning, each volume in a disk pool should be larger than your largest backup. NetBackup then can store your largest backup on a single volume if that volume does not contain other backup images.

**Note:** Some file systems limitations can affect whether or not NetBackup can detect file system capacity accurately. On those file systems, Veritas recommends that you do not span backup images across volumes.

See “About AdvancedDisk file system requirements” on page 13.

**Disk size and performance**

NetBackup assumes that all disk volumes within a disk pool are similar in size and performance characteristics. Although you can use dissimilar disk volumes in a disk pool, performance may be unpredictable.

If you have the disk volumes that have significantly different characteristics, group them into multiple disk pools. Each of those disk pools should contain the volumes that have similar characteristics.

**Disk contention**

NetBackup queues backup and restore jobs if insufficient resources are available.

To limit the possibility of write contention between backup jobs (and therefore job queuing), ensure that a disk pool contains a sufficient number of volumes. The number of volumes should be equal to or greater than: the total number of maximum concurrent jobs that are allowed in all of the storage units that use a disk pool.

**Volume managers**

The AdvancedDisk storage implementation presents mounted file systems as disk volumes to NetBackup. Therefore, you can use AdvancedDisk disk pools with the volume managers that work at a level closer to the hardware than the file system.
Configuring a CIFS disk volume for AdvancedDisk encryption

AdvancedDisk_crypt and CIFS only.

For the AdvancedDisk_crypt disk type, you must use the NetBackup nbdevconfig command to specify each CIFS disk volume for the disk pool. You must also use the UNC notation to specify the volumes (NetBackup cannot discover Windows Common Internet File System (CIFS) disk volumes).

See “About AdvancedDisk file system requirements” on page 13.

Veritas recommends that disk volume and disk pool names be unique across your enterprise.

You must first configure storage servers.

See “Configuring an AdvancedDisk storage server” on page 27.

To configure an AdvancedDisk disk volume by using the command line

1. On the NetBackup master server, configure the volume by using the following command:

   `nbdevconfig -createdv -storage_server hostname -stype server_type -dv disk_volume_name -dp disk_pool_name`

   The following is the path to the nbdevconfig command:
   - UNIX: `/usr/openv/netbackup/bin/admincmd`
   - Windows: `install_path\NetBackup\bin\admincmd`

   The following describe the options:

   - `-storage_server hostname` The name of the NetBackup media server that has a file system mount on the storage.
   - `-stype server_type` For AdvancedDisk with encryption, use AdvancedDisk_crypt, otherwise use AdvancedDisk.
   - `-dv disk_volume_name` The name of the disk volume; use UNC notation.
   - `-dp disk_pool_name` The name of the disk pool for the volume.

2. Repeat step 1 for each disk volume that you want to add.
Configuring an AdvancedDisk disk pool

How you configure an AdvancedDisk disk pool depends on the type, as follows:

**AdvancedDisk_crypt type**

You must use the `nbdevconfig` command if you configured an AdvancedDisk_crypt type of storage server. NetBackup encrypts the backup data on the AdvancedDisk_crypt type of disk pool.

See “To configure an AdvancedDisk disk pool by using the nbdevconfig command” on page 43.

NetBackup cannot discover Windows Common Internet File System (CIFS) disk volumes. For CIFS storage, you must use the UNC notation to specify the volumes.

See “About AdvancedDisk file system requirements” on page 13.

See “Configuring a CIFS disk volume for AdvancedDisk encryption” on page 41.

**AdvancedDisk type**

Veritas recommends that you use the Disk Pool Configuration Wizard to configure the AdvancedDisk type of disk pool. When you configure a storage server, that wizard continues to the Disk Pool Configuration Wizard. Therefore, you may not need to invoke the disk pool wizard separately.

See “To configure an AdvancedDisk disk pool by using the wizard” on page 44.

NetBackup cannot discover Windows Common Internet File System (CIFS) disk volumes. For CIFS storage, you must use the UNC notation to specify the volumes.

See “About AdvancedDisk file system requirements” on page 13.

Veritas recommends that disk volume and disk pool names be unique across your enterprise.

You must first configure storage servers.

See “Configuring an AdvancedDisk storage server” on page 27.
To configure an AdvancedDisk disk pool by using the `nbdevconfig` command

1. On the host that has a file system mount on the storage, discover the volumes that are available and write them to a text file. If you intend to use multiple hosts to read to and write from the storage, use any of the hosts. The following is the NetBackup command to use, depending on your operating system:

   **UNIX:**
   ```bash
   /usr/openv/netbackup/bin/admincmd/nbdevconfig -previewdv -storage_server hostname -stype server_type > filename
   ```

   **Windows:**
   ```bash
   install_path\NetBackup\bin\admincmd\nbdevconfig -previewdv -storage_server hostname -stype server_type > filename
   ```

   The following describe the options:

   - `-storage_server hostname` The name of the NetBackup media server that has a file system mount on the storage.
   - `-stype server_type` For AdvancedDisk with encryption, use `AdvancedDisk_crypt`, otherwise use `AdvancedDisk`.
   - `> filename` The name of the file into which to write the volume information. Veritas recommends that you use a name that describes its purpose.

2. Copy the file that you created in step 1 to the master server.
3 In a text editor, delete the line for each volume that you do not want to be in the disk pool. Do not delete the blank line at the end of the file. Each volume that is listed in the file must be exposed to each AdvancedDisk storage server on the same mount point.

4 Configure the disk pool by using the following command, depending on your operating system:

**UNIX:**
```
/usr/openv/netbackup/bin/admincmd/nbdevconfig -createdp -dp disk_pool_name -stype server_type -storage_servers hostname... -dvlist filename [-reason "string"] [-lwm low_watermark_percent] [-max_io_streams n] [-comment comment] [-M master_server] [-reason "string"]
```

**Windows:**
```
install_path\NetBackup\bin\admincmd\nbdevconfig -createdp -dp disk_pool_name -stype server_type -storage_servers hostname... -dvlist filename [-reason "string"] [-lwm low_watermark_percent] [-max_io_streams n] [-comment comment] [-M master_server] [-reason "string"]
```

The nbdevconfig command options are described in a different topic.

See “NetBackup nbdevconfig command options for AdvancedDisk disk pools” on page 51.

To configure an AdvancedDisk disk pool by using the wizard

1 In the NetBackup Administration Console, select either NetBackup Management or Media and Device Management.

2 From the list of wizards in the right pane, click Configure Disk Pool.
3 On the **Welcome** panel, the types of disk pools that you can configure depend on the options for which you are licensed.

The following is an example of the wizard panel:

![Disk Pool Configuration Wizard](image)

Select **AdvancedDisk** and then click **Next**. The **Storage Server Selection** wizard panel appears.
4 On the **Storage Server Selection** panel, all NetBackup media servers that you configured as AdvancedDisk storage servers appear.

The following is an example of the wizard panel:

Select the NetBackup media servers that you want to function as storage servers for this disk pool and then click **Next**. The **Volume Selection** wizard panel appears.
5 The Volume Selection panel displays the volumes available on the storage server. If you selected more than one storage server, volumes that are common to all of them appear.

The following is an example of the wizard panel:

To specify a Common Internet File System (CIFS) disk volume, click Add New Volume. In the Add New Volume dialog box, enter the Windows Universal Naming Convention (UNC) pathname of the CIFS volume and then click Validate and Add.

Select the volumes to use for the disk pool. NetBackup does not filter out common file system mount points, such as / and /usr. Therefore, carefully choose the volumes to include in a disk pool.
See “About AdvancedDisk file system requirements” on page 13.

Click **Next**. The **Additional Disk Pool Information** wizard panel appears.

6

On the **Additional Disk Pool Information** panel, enter the values for the disk pool and then click **Next**.

See “**AdvancedDisk disk pool properties**” on page 53.

The following is an example of the wizard panel:

![Disk Pool Configuration Wizard](image)

The **Summary** wizard panel appears after you click **Next**.
7 On the **Summary** panel, verify the selections. If OK, click **Next**.

The following is an example of the wizard panel:
After NetBackup creates the disk pool, a wizard panel describes the successful action.

The following is an example of the wizard panel:

![Disk Pool Configuration Wizard](image)

After NetBackup creates the disk pool, you can do the following:

- **Configure a storage unit**: Ensure that **Create a storage unit using the disk pool that you have just created** is selected and then click **Next**. The **Storage Unit Creation** wizard panel appears. Continue to the next step.

- **Exit**: Click **Close**.

  You can configure one or more storage units later.

  See “Configuring an AdvancedDisk disk pool” on page 42.
9 On **Storage Unit Creation** wizard panel, enter the appropriate information for the storage unit.

The following is an example of the wizard panel:

![Disk Pool Configuration Wizard](image)

See “**AdvancedDisk storage unit properties**” on page 57.

Click **Next** to create the storage unit.

10 After NetBackup configures the storage unit, the **Finished** panel appears. Click **Finish** to exit from the wizard.

**NetBackup nbdevconfig command options for AdvancedDisk disk pools**

*Table 3-7* shows the options that you can use when you use the `nbdevconfig` command to configure an AdvancedDisk disk pool.
### nbdevconfig command options for AdvancedDisk disk pools

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-comment comment</code></td>
<td>A comment that is associated with the disk pool.</td>
</tr>
<tr>
<td><code>-dp disk_pool_name</code></td>
<td>The name of the disk pool. Use the same name that you used when you configured the disk volumes.</td>
</tr>
<tr>
<td><code>-dvlist filename</code></td>
<td>The name of the file that contains the information about the volumes for the disk pool.</td>
</tr>
<tr>
<td><code>-hwm high_watermark</code></td>
<td>The <code>high_watermark</code> setting is a threshold that triggers the following actions:</td>
</tr>
<tr>
<td></td>
<td>- When an individual volume in the disk pool reaches the <code>high_watermark</code>, NetBackup considers the volume full. NetBackup chooses a different volume in the disk pool to write backup images to.</td>
</tr>
<tr>
<td></td>
<td>- When all volumes in the disk pool reach the <code>high_watermark</code>, the disk pool is considered full. NetBackup fails any backup jobs that are assigned to a storage unit in which the disk pool is full. NetBackup also does not assign new jobs to a storage unit in which the disk pool is full.</td>
</tr>
<tr>
<td></td>
<td>- NetBackup begins image cleanup when a volume reaches the <code>high_watermark</code>; image cleanup expires the images that are no longer valid. For a disk pool that is full, NetBackup again assigns jobs to the storage unit when image cleanup reduces any disk volume's capacity to less than the <code>high_watermark</code>.</td>
</tr>
<tr>
<td></td>
<td>If the storage unit for the disk pool is in a capacity-managed storage lifecycle policy, other factors affect image cleanup.</td>
</tr>
<tr>
<td></td>
<td>The default is 98%.</td>
</tr>
<tr>
<td><code>-lwm low_watermark</code></td>
<td>The <code>Low water mark</code> is a threshold at which NetBackup stops image cleanup. The <code>Low water mark</code> setting cannot be greater than or equal to the <code>High water mark</code> setting.</td>
</tr>
<tr>
<td></td>
<td>The default is 80%.</td>
</tr>
<tr>
<td><code>-M master_server</code></td>
<td>The name of the master server.</td>
</tr>
</tbody>
</table>
Table 3-7 nbdevconfig command options for AdvancedDisk disk pools (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-max_io Streams (n)</td>
<td>Select this option to limit the number of read and write streams (that is, jobs) for each volume in the disk pool. A job may read backup images or write backup images. By default, there is no limit. When the limit is reached, NetBackup chooses another volume, if available. If not available, NetBackup queues jobs until a volume is available. Too many jobs that read and write data may degrade disk performance because of disk thrashing. (Disk thrashing is when the read and write heads move between the cylinders excessively as they seek the data for competing jobs.) Fewer streams may improve throughput, which may increase the number of jobs that complete in a specific time period. A starting point is to divide the Maximum concurrent jobs of all of the storage units by the number of volumes in the disk pool.</td>
</tr>
<tr>
<td>-reason &quot;string&quot;</td>
<td>The reason that you create the disk pool.</td>
</tr>
<tr>
<td>-storage_servers hostname</td>
<td>The name of each storage server that has a file system mount on the storage. Specify all NetBackup media servers that are storage servers for this disk pool.</td>
</tr>
<tr>
<td>-type server_type</td>
<td>For AdvancedDisk with encryption, use AdvancedDisk_crypt, otherwise use AdvancedDisk.</td>
</tr>
</tbody>
</table>

AdvancedDisk disk pool properties

Table 3-8 describes the disk pool properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The disk pool name.</td>
</tr>
<tr>
<td>Storage server</td>
<td>The storage server or storage servers.</td>
</tr>
<tr>
<td></td>
<td>All NetBackup media servers that have a mount on the storage are listed. They share the storage for read and write purposes.</td>
</tr>
<tr>
<td>Disk volumes</td>
<td>The disk volumes that comprise the disk pool.</td>
</tr>
<tr>
<td>Total size</td>
<td>The total amount of space available in the disk pool.</td>
</tr>
<tr>
<td>Total raw size</td>
<td>The total raw, unformatted size of the storage in the disk pool.</td>
</tr>
<tr>
<td>Comment</td>
<td>A comment that is associated with the disk pool.</td>
</tr>
</tbody>
</table>
### Table 3-8 AdvancedDisk disk pool properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| High water mark | The **High water mark** setting is a threshold that triggers the following actions:  
+ When an individual volume in the disk pool reaches the **High water mark**, NetBackup considers the volume full. NetBackup chooses a different volume in the disk pool to write backup images to.  
+ When all volumes in the disk pool reach the **High water mark**, the disk pool is considered full. NetBackup fails any backup jobs that are assigned to a storage unit in which the disk pool is full. NetBackup also does not assign new jobs to a storage unit in which the disk pool is full.  
+ NetBackup begins image cleanup when a volume reaches the **High water mark**; image cleanup expires the images that are no longer valid. For a disk pool that is full, NetBackup again assigns jobs to the storage unit when image cleanup reduces any disk volume’s capacity to less than the **High water mark**.  
  
  If the storage unit for the disk pool is in a capacity-managed storage lifecycle policy, other factors affect image cleanup.  
  
  The default is 98%. |
| Low water mark | The **Low water mark** is a threshold at which NetBackup stops image cleanup.  
  
  The **Low water mark** setting cannot be greater than or equal to the **High water mark** setting.  
  
  The default is 80%. |
| Limit I/O streams | Select this option to limit the number of read and write streams (that is, jobs) for each volume in the disk pool. A job may read backup images or write backup images. By default, there is no limit.  
  
  When the limit is reached, NetBackup chooses another volume, if available. If not available, NetBackup queues jobs until a volume is available.  
  
  Too many jobs that read and write data may degrade disk performance because of disk thrashing. (Disk thrashing is when the read and write heads move between the cylinders excessively as they seek the data for competing jobs.)  
  
  Fewer streams may improve throughput, which may increase the number of jobs that complete in a specific time period.  
  
  A starting point is to divide the **Maximum concurrent jobs** of all of the storage units by the number of volumes in the disk pool. |
| per volume     | Select or enter the number of read and write streams to allow per volume.  
  
  Many factors affect the optimal number of streams. Factors include but are not limited to disk speed, CPU speed, and the amount of memory. |
Configuring an AdvancedDisk storage unit

Create one or more storage units that reference the disk pool.

The Disk Pool Configuration Wizard lets you create a storage unit; therefore, you may have created a storage unit when you created a disk pool. To determine if storage units exist for the disk pool, see the NetBackup Management > Storage > Storage Units window of the NetBackup Administration Console.

See “About AdvancedDisk storage unit recommendations” on page 58.

More information about storage units is available. See the NetBackup Administrator's Guide, Volume I:

http://www.veritas.com/docs/DOC5332
To configure a storage unit from the Actions menu

1. In the NetBackup Administration Console, in the left pane, select NetBackup Management > Storage > Storage Units.

2. Click Actions > New > Storage Unit.

3. Complete the fields and set the options in the New Storage Unit dialog box. See “AdvancedDisk storage unit properties” on page 57.

4. Click OK.
AdvancedDisk storage unit properties

The following are the configuration options for a disk pool storage unit.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage unit name</td>
<td>Enter a unique name for the new storage unit. The name can describe the type of storage. The storage unit name is the name used to specify a storage unit for policies and schedules. The storage unit name cannot be changed after creation.</td>
</tr>
<tr>
<td>Storage unit type</td>
<td>Select Disk as the storage unit type.</td>
</tr>
<tr>
<td>Disk type</td>
<td>Select AdvancedDisk for the disk type.</td>
</tr>
<tr>
<td>Disk pool</td>
<td>Select the disk pool that contains the storage for this storage unit. All disk pools of the specified Disk type appear in the Disk pool list. If no disk pools are configured, no disk pools appear in the list.</td>
</tr>
<tr>
<td>Media server</td>
<td>Specify the NetBackup media servers that can move data to and from the disk pool for this storage unit. Only the media servers that are configured as storage servers appear in the media servers list. Specify the media server or servers as follows:</td>
</tr>
<tr>
<td></td>
<td>■ To allow any server in the media server list to access the disk storage (default), select Use any available media server.</td>
</tr>
<tr>
<td></td>
<td>■ To restrict the media servers that can access the disk storage, select Only use the following media servers. Then, select the media servers to allow. The selection list includes only the media servers that are configured as storage servers for the disk pool.</td>
</tr>
<tr>
<td></td>
<td>NetBackup selects the media server to use when the policy runs.</td>
</tr>
<tr>
<td>Maximum concurrent jobs</td>
<td>Specify the maximum number of write jobs that NetBackup can send to a disk storage unit at one time. (Default: one job. The job count can range from 0 to 256.) This setting corresponds to the Maximum concurrent write drives setting for a tape storage unit. NetBackup queues jobs until the storage unit is available. If three backup jobs are scheduled and Maximum concurrent jobs is set to two, NetBackup starts the first two jobs and queues the third job. If a job contains multiple copies, each copy applies toward the Maximum concurrent jobs count. Maximum concurrent jobs controls the traffic for backup and duplication jobs but not restore jobs. The count applies to all servers in the storage unit, not per server. If you select multiple media servers in the storage unit and 1 for Maximum concurrent jobs, only one job runs at a time. The number to enter depends on the available disk space and the server's ability to run multiple backup processes.</td>
</tr>
<tr>
<td></td>
<td>Warning: A Maximum concurrent jobs setting of 0 disables the storage unit.</td>
</tr>
</tbody>
</table>
Table 3-9  AdvancedDisk storage unit properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum fragment size</td>
<td>Specify the largest fragment size that NetBackup can create to store backups. The default maximum fragment size for a disk storage unit is 524,288 megabytes. To specify a maximum fragment size other than the default, enter a value from 20 megabytes to 524,288 megabytes. Backups to disk are usually fragmented to ensure that the backup does not exceed the maximum size that the file system allows. If an error occurs in a backup, the entire backup is discarded. The backup restarts from the beginning, not from the fragment where the error occurred. (An exception is for backups for which checkpoint and restart are enabled. In that case, fragments before and including the last checkpoint are retained; the fragments after the last checkpoint are discarded.)</td>
</tr>
</tbody>
</table>

About AdvancedDisk storage unit recommendations

You can use storage unit properties to control how NetBackup moves backup and duplication data.

For example, you can configure a favorable client-to-server ratio for important clients by using the storage unit Media server setting.

See “About AdvancedDisk storage unit recommendations” on page 58.

You also can use the storage unit Maximum concurrent jobs setting to control the backup or the duplication traffic that is sent to the media servers.

See “About throttling traffic to the media servers” on page 59.

About configuring a favorable client-to-server ratio

For a favorable client-to-server ratio, you can use one disk pool and configure multiple storage units to separate your backup traffic. Because all storage units use the same disk pool, you do not have to partition the storage.

For example, assume that you have 100 important clients, 500 regular clients, and four media servers. You can use two media servers to back up your most important clients and two media servers to back up your regular clients.

The following example describes how to configure a favorable client-to-server ratio:

- Configure the media servers for AdvancedDisk and configure the storage.
- Configure a disk pool.
- Configure a storage unit for your most important clients (such as STU-GOLD). Select the disk pool. Select **Only use the following media servers**. Select two media servers to use for your important backups.

- Create a backup policy for the 100 important clients and select the STU-GOLD storage unit. The media servers that are specified in the storage unit move the client data to the storage server.

- Configure another storage unit (such as STU-SILVER). Select the same disk pool. Select **Only use the following media servers**. Select the other two media servers.

- Configure a backup policy for the 500 regular clients and select the STU-SILVER storage unit. The media servers that are specified in the storage unit move the client data to the storage server.

Backup traffic is routed to the wanted data movers by the storage unit settings.

---

**Note:** NetBackup uses storage units for media server selection for write activity (backups and duplications) only. For restores, NetBackup chooses among all media servers that can access the disk pool.

---

**About throttling traffic to the media servers**

You can use the **Maximum concurrent jobs** settings on disk pool storage units to throttle the traffic to the media servers. Effectively, this setting also directs higher loads to specific media servers when you use multiple storage units for the same disk pool. A higher number of concurrent jobs means that the disk can be busier than if the number is lower.

For example, two storage units use the same set of media servers. One of the storage units (STU-GOLD) has a higher **Maximum concurrent jobs** setting than the other (STU-SILVER). More client backups occur for the storage unit with the higher **Maximum concurrent jobs** setting.

---

**About storage lifecycle policies**

A storage lifecycle policy (SLP) is a storage plan for a set of backups. An SLP is configured within the **Storage Lifecycle Policies** utility.

An SLP contains instructions in the form of storage operations, to be applied to the data that is backed up by a backup policy. Operations are added to the SLP that determine how the data is stored, copied, replicated, and retained. NetBackup retries the copies as necessary to ensure that all copies are created.
SLPs offer the opportunity for users to assign a classification to the data at the policy level. A data classification represents a set of backup requirements, which makes it easier to configure backups for data with different requirements. For example, email data and financial data.

SLPs can be set up to provide staged backup behavior. They simplify data management by applying a prescribed behavior to all the backup images that are included in the SLP. This process allows the NetBackup administrator to leverage the advantages of disk-based backups in the near term. It also preserves the advantages of tape-based backups for long-term storage.

The **SLP Parameters** properties in the **NetBackup Administration Console** allow administrators to customize how SLPs are maintained and how SLP jobs run.

Best-practice information about SLPs appears in the following document:

http://www.veritas.com/docs/TECH208536

---

**Creating a storage lifecycle policy**

A storage lifecycle policy (SLP) is a storage plan for a set of backups. The operations in an SLP are the backup instructions for the data. Use the following procedure to create an SLP that contains multiple storage operations.

**To add a storage operation to a storage lifecycle policy**

1. In the **NetBackup Administration Console**, select **NetBackup Management > Storage > Storage Lifecycle Policies**.
2. Click **Actions > New > New Storage Lifecycle Policy** (Windows) or **Actions > New > Storage Lifecycle Policy** (UNIX).
3 In the **New Storage Lifecycle Policy** dialog box, enter a **Storage lifecycle policy name**.

4 Add one or more operations to the SLP. The operations are the instructions for the SLP to follow and apply to the data that is specified in the backup policy.

   If this is the first operation added to the SLP, click **Add**.

   If this is not the first operation in the SLP, add an operation that is either hierarchical or non-hierarchical:

   To create a hierarchical operation, select an operation to become the source of the next operation. Click **Add**. The new operation is a child of the selected operation. The child is indented under the parent operation.

   ![Change Storage Lifecycle Policy](image)

   To create a non-hierarchical operation, do not select an operation. A non-hierarchical operation means that the operation does not have a parent and child relationship with another operation. The new operation is not indented.

   ![New Storage Lifecycle Policy](image)

5 In the **Properties** tab of the **New Storage Operation** dialog box, select an **Operation** type. If you're creating a child operation, the SLP displays only those operations that are valid based on the parent operation that you've selected.

   The name of the operation reflects its purpose in the SLP:

   - **Backup**
   - **Duplication**
   - **Import**

6 Configure the properties for the operation.
The Window tab displays for the following operation types: Backup From Snapshot, Duplication, Import, Index From Snapshot, and Replication. If you’d like to control when the secondary operation runs, create a window for the operation.

Click the Advanced button in the Properties tab to display options about how the window should behave if the window closes and a secondary operation is not yet complete.

Click OK to create the operation.

Add additional operations to the SLP as needed. (See step 4.)

Change the hierarchy of the operations in the SLP if necessary.

Click OK to create the SLP. NetBackup validates the SLP when it is first created and whenever it is changed.

Configure a backup policy and select a storage lifecycle policy as the Policy storage.

See “Creating a backup policy” on page 65.

Storage Lifecycle Policy dialog box settings

The New Storage Lifecycle Policy dialog box and the Change Storage Lifecycle Policy dialog box contain the following settings.

![Storage Lifecycle Policy dialog box settings](image)
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage lifecycle policy name</td>
<td>The <strong>Storage lifecycle policy name</strong> describes the SLP. The name cannot be modified after the SLP is created.</td>
</tr>
<tr>
<td>Data classification</td>
<td>The <strong>Data classification</strong> defines the level or classification of data that the SLP is allowed to process. The drop-down menu contains all of the defined classifications as well as the <strong>Any</strong> classification, which is unique to SLPs.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Any</strong> selection indicates to the SLP that it should preserve all images that are submitted, regardless of their data classification. It is available for SLP configuration only and is not available to configure a backup policy.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Data classification</strong> is an optional setting.</td>
</tr>
<tr>
<td></td>
<td>One data classification can be assigned to each SLP and applies to all operations in the SLP.</td>
</tr>
<tr>
<td></td>
<td>If a data classification is selected (other than <strong>Any</strong>), the SLP stores only those images from the policies that are set up for that data classification. If no data classification is indicated, the SLP accepts images of any classification or no classification.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Data classification</strong> setting allows the NetBackup administrator to classify data based on relative importance. A classification represents a set of backup requirements. When data must meet different backup requirements, consider assigning different classifications.</td>
</tr>
<tr>
<td></td>
<td>For example, email backup data can be assigned to the silver data classification and financial data backup may be assigned to the platinum classification.</td>
</tr>
<tr>
<td></td>
<td>A backup policy associates backup data with a data classification. Policy data can be stored only in an SLP with the same data classification.</td>
</tr>
<tr>
<td></td>
<td>Once data is backed up in an SLP, the data is managed according to the SLP configuration. The SLP defines what happens to the data from the initial backup until the last copy of the image has expired.</td>
</tr>
<tr>
<td>Priority for secondary operations</td>
<td>The <strong>Priority for secondary operations</strong> option is the priority that jobs from secondary operations have in relationship to all other jobs. The priority applies to the jobs that result from all operations except for <strong>Backup</strong> and <strong>Snapshot</strong> operations. Range: 0 (default) to 99999 (highest priority).</td>
</tr>
<tr>
<td></td>
<td>For example, you may want to set the <strong>Priority for secondary operations</strong> for a policy with a gold data classification higher than for a policy with a silver data classification.</td>
</tr>
<tr>
<td></td>
<td>The priority of the backup job is set in the backup policy on the <strong>Attributes</strong> tab.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Operations</td>
<td>Use the <strong>Add</strong>, <strong>Change</strong>, and <strong>Remove</strong> buttons to create a list of operations in the SLP. An SLP must contain one or more operations. Multiple operations imply that multiple copies are created.</td>
</tr>
<tr>
<td></td>
<td>The list also contains the columns that display information about each operation. Not all columns display by default.</td>
</tr>
<tr>
<td></td>
<td>For column descriptions, see the following topic:</td>
</tr>
<tr>
<td>Arrows</td>
<td>Use the arrows to indicate the indentation (or hierarchy) of the source for each copy. One copy can be the source for many other copies.</td>
</tr>
<tr>
<td>Active and Postponed</td>
<td>The <strong>Active</strong> and <strong>Postponed</strong> options appear under <strong>State of Secondary Operation Processing</strong> and refer to the processing of all duplication operations in the SLP.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The <strong>Active</strong> and <strong>Postponed</strong> options apply to duplication operations that create tar-formatted images. For example, those created with <code>bpduplicate</code>. The <strong>Active</strong> and <strong>Postponed</strong> options do not affect the images that are duplicated as a result of OpenStorage optimized duplication, NDMP, or if one or more destination storage units are specified as part of a storage unit group.</td>
</tr>
<tr>
<td></td>
<td>These options do not apply if either the source media server or the destination media server is not at NetBackup 7.6 or later.</td>
</tr>
<tr>
<td></td>
<td>■ Enable <strong>Active</strong> to let secondary operations continue as soon as possible. When changed from <strong>Postponed</strong> to <strong>Active</strong>, NetBackup continues to process the images, picking up where it left off when secondary operations were made inactive.</td>
</tr>
<tr>
<td></td>
<td>■ Enable <strong>Postponed</strong> to postpone the secondary operations for the entire SLP. <strong>Postponed</strong> does not postpone the creation of duplication jobs, it postpones the creation of images instead. The duplication jobs continue to be created, but they are not run until secondary operations are active again.</td>
</tr>
<tr>
<td></td>
<td>All secondary operations in the SLP are inactive indefinitely unless the administrator selects <strong>Active</strong> or until the <strong>Until</strong> option is selected and an activation date is indicated.</td>
</tr>
<tr>
<td>Validate Across</td>
<td>Click this button to see how changes to this SLP can affect the policies that are associated with this SLP. The button generates a report that displays on the <strong>Validation Report</strong> tab.</td>
</tr>
<tr>
<td>Backup Policies</td>
<td>This button performs the same validation as the <code>-conflict</code> option performs when used with the <code>nbstl</code> command.</td>
</tr>
<tr>
<td>button</td>
<td></td>
</tr>
</tbody>
</table>
Creating a backup policy

The easiest method to set up a backup policy is to use the Policy Configuration Wizard. This wizard guides you through the setup process by automatically choosing the best values for most configurations.

Not all policy configuration options are presented through the wizard. For example, calendar-based scheduling and the Data Classification setting. After the policy is created, modify the policy in the Policies utility to configure the options that are not part of the wizard.

**Note:** Do not use the Policy Configuration Wizard to configure policies for Replication Director.

**Using the Policy Configuration Wizard to create a backup policy**

Use the following procedure to create a backup policy with the Policy Configuration Wizard.

**To create a backup policy with the Policy Configuration Wizard**

1. In the NetBackup Administration Console, in the left pane, click NetBackup Management.
2. In the right pane, click Create a Policy to begin the Policy Configuration Wizard.
3. Click Next to start the wizard and follow the prompts.

Click Help on any wizard panel for assistance while running the wizard.

**Creating a backup policy without using the Policy Configuration Wizard**

Use the following procedure to create a backup policy in the NetBackup Administration Console without using the Policy Configuration Wizard.

**To create a policy without the Policy Configuration Wizard**

1. In the NetBackup Administration Console, in the left pane, expand NetBackup Management > Policies.
2. On the Actions menu, click New > Policy.
3. Type a unique name for the new policy in the Add a New Policy dialog box.
4. If necessary, clear the Use Policy Configuration Wizard check box.
5 Click OK.
6 Configure the attributes, the schedules, the clients, and the backup selections for the new policy.

**Resilient Network properties**

The Resilient Network properties appear for the master server, for media servers, and for clients. For media servers and clients, the Resilient Network properties are read only. When a job runs, the master server updates the media server and the client with the current properties.

The Resilient Network properties let you configure NetBackup to use resilient network connections for backups and restores. A resilient connection allows backup and restore traffic between a client and a NetBackup media server to function effectively in high-latency, low-bandwidth networks such as WANs. The data travels across a wide area network (WAN) to media servers in a central datacenter.

NetBackup monitors the socket connections between the remote client and the NetBackup media server. If possible, NetBackup re-establishes dropped connections and resynchronizes the data stream. NetBackup also overcomes latency issues to maintain an unbroken data stream. A resilient connection can survive network interruptions of up to 80 seconds. A resilient connection may survive interruptions longer than 80 seconds.

The NetBackup Remote Network Transport Service manages the connection between the computers. The Remote Network Transport Service runs on the master server, the client, and the media server that processes the backup or restore job. If the connection is interrupted or fails, the services attempt to re-establish a connection and synchronize the data.

NetBackup protects only the network socket connections that the NetBackup Remote Network Transport Service (`nbrntd`) creates. Examples of the connections that are not supported are:

- Clients that back up their own data (deduplication clients and SAN clients)
- Granular Recovery Technology (GRT) for Exchange Server or SharePoint Server
- NetBackup `nbfsd` process.

NetBackup protects connections only after they are established. If NetBackup cannot create a connection because of network problems, there is nothing to protect.

Resilient connections apply between clients and NetBackup media servers, which includes master servers when they function as media servers. Resilient connections do not apply to master servers or media servers if they function as clients and back up data to a media server.
Resilient connections can apply to all of the clients or to a subset of clients.

**Note:** If a client is in a different subdomain than the server, add the fully qualified domain name of the server to the client’s hosts file. For example, `india.veritas.org` is a different subdomain than `china.veritas.org`.

When a backup or restore job for a client starts, NetBackup searches the **Resilient Network** list from top to bottom looking for the client. If NetBackup finds the client, NetBackup updates the resilient network setting of the client and the media server that runs the job. NetBackup then uses a resilient connection.

**Figure 3-2** Master server Resilient Network host properties

Table 3-11 describes the **Resilient Network** properties.
Table 3-11  Resilient Network dialog box properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Host Name or IP Address | The Host Name or IP Address of the host. The address can also be a range of IP addresses so you can configure more than one client at once. You can mix IPv4 addresses and ranges with IPv6 addresses and subnets.  
If you specify the host by name, Veritas recommends that you use the fully qualified domain name.  
Use the arrow buttons on the right side of the pane to move up or move down an item in the list of resilient networks. |
| Resiliency           | Resiliency is either On or Off.                                                                                                                                                                             |

**Note:** The order is significant for the items in the list of resilient networks. If a client is in the list more than once, the first match determines its resilient connection status. For example, suppose you add a client and specify the client IP address and specify On for Resiliency. Suppose also that you add a range of IP addresses as Off, and the client IP address is within that range. If the client IP address appears before the address range, the client connection is resilient. Conversely, if the IP range appears first, the client connection is not resilient.

The resilient status of each client also appears as follows:

- In the NetBackup Administration Console, select NetBackup Management > Policies in the left pane and then select a policy. In the right pane, a Resiliency column shows the status for each client in the policy.
- In the NetBackup Administration Console, select NetBackup Management > Host Properties > Clients in the left pane. In the right pane, a Resiliency column shows the status for each client.

Other NetBackup properties control the order in which NetBackup uses network addresses.

The NetBackup resilient connections use the SOCKS protocol version 5.

Resilient connection traffic is not encrypted. Veritas recommends that you encrypt your backups. For deduplication backups, use the deduplication-based encryption. For other backups, use policy-based encryption.

Resilient connections apply to backup connections. Therefore, no additional network ports or firewall ports must be opened.
**Specifying resilient connections**

Use the following procedure to specify resilient connections for NetBackup clients.

See "Resilient Network properties" on page 66.

Alternatively, you can use the `resilient_clients` script to specify resilient connections for clients:

- **Windows:** `install_path\NetBackup\bin\admincmd\resilient_clients`
- **UNIX:** `/usr/openv/netbackup/bin/admincmd/resilient_clients`

To specify resilient connections

1. In the **NetBackup Administration Console**, expand **NetBackup Management > Host Properties > Master Servers** in the left pane.
2. In the right pane, select the master server on which to specify properties.
3. On the **Actions** menu, click **Properties**.
4. In the properties dialog box left pane, select **Resilient Network**.
5. In the **Resilient Network** dialog box, use the following buttons to manage resiliency for clients:
Add
To add resilient settings
1 Click Add.
   The Add Resilient Network Settings dialog box appears
2 Enter a client host name, an IP address, or an address range.
   If you specify the client host by name, Veritas recommends that you use the fully qualified domain name.
   For address ranges, use Classless Inter-Domain Routing (CIDR) notation (for example, 192.168.100.0/24 or fd00::/8).
3 Ensure that the Resiliency On option is selected.
4 Click Add.
5 Repeat until you have finished entering clients or address ranges.
6 When you finish adding network settings, click Close.

Add To All
If you select multiple hosts in the NetBackup Administration Console, the entries in the Resilient Network list may appear in different colors, as follows:
- The entries that appear in black type are configured on all of the hosts.
- The entries that appear in gray type are configured on some of the hosts only.
For the entries that are configured on some of the hosts only, you can add them to all of the hosts. To do so, select them and click Add To All.

Change
To change resilient settings
1 Select the client host name, the IP address, or the address range.
2 Click Change.
   The Change Resilient Network Settings dialog box appears
3 Select the desired Resiliency setting.
4 Click OK.

Remove
Remove the select host or address range
1 Select the client host name, the IP address, or the address range.
2 Click Remove.
   The client is removed immediately; a confirmation dialog box does not appear.
Move an item in the list of items

1 Select the client host name, the IP address, or the address range.

2 Click the appropriate button to move up the item or move down the item.

The order of the items in the list is significant.

See “Resilient Network properties” on page 66.

6 After specifying resilient connections, click OK.

The settings are propagated to the affected hosts through normal NetBackup inter-host communication, which can take up to 15 minutes.

7 If you want to begin a backup immediately, restart the NetBackup services on the master server.
Managing AdvancedDisk

This chapter includes the following topics:

- Managing AdvancedDisk storage servers
- Managing AdvancedDisk disk pools
- About monitoring AdvancedDisk storage capacity and usage
- Monitoring NetBackup disk activity
- Viewing AdvancedDisk disk reports
- Displaying detailed AdvancedDisk storage usage information
- Displaying KMS key information for AdvancedDisk encryption

Managing AdvancedDisk storage servers

After you configure AdvancedDisk, you can perform various tasks to manage storage servers.

See “Viewing AdvancedDisk storage servers” on page 73.
See “Determining AdvancedDisk storage server state” on page 73.
See “Viewing AdvancedDisk storage server attributes” on page 73.
See “Removing AdvancedDisk storage server attributes” on page 74.
See “Removing an AdvancedDisk storage server from disk pool access” on page 75.
See “Deleting an AdvancedDisk storage server” on page 75.
Viewing AdvancedDisk storage servers

Use the NetBackup Administration Console to view a list of storage servers already configured.

To view AdvancedDisk storage servers

- In the NetBackup Administration Console, in the left pane, expand Media and Device Management > Credentials > Storage Server.

  The right pane, labeled All Storage Servers, shows all configured storage servers. AdvancedDisk storage servers show AdvancedDisk in the Server Type column.

Determining AdvancedDisk storage server state

Use the NetBackup nbdevquery command to determine the state of an AdvancedDisk storage server.

To determine AdvancedDisk storage server status

- Run the following command:
  
  **UNIX:**
  ```bash
  /usr/openv/netbackup/bin/admincmd/nbdevquery -liststs -stype AdvancedDisk -storage_server server_name -U
  ```
  
  **Windows:**
  ```bash
  \install_path\NetBackup\bin\admincmd\nbdevquery -liststs -stype AdvancedDisk -storage_server server_name -U
  ```

  The State field of the command output shows either UP or DOWN.

Viewing AdvancedDisk storage server attributes

Use the NetBackup nbdevquery command to view the storage server attributes.

The following is the path to the nbdevconfig command:

- **UNIX:**
  ```bash
  /usr/openv/netbackup/bin/admincmd
  ```

- **Windows:**
  ```bash
  \install_path\NetBackup\bin\admincmd
  ```
To view AdvancedDisk storage server attributes

- Run the following command on the NetBackup master server or a storage server:

```
nbdevquery -liststs -storage_server storage_server -stype AdvancedDisk -U
```

The following is example output:

```
Storage Server : advdsk_server.example.com
Storage Server Type : AdvancedDisk
Storage Type : Formatted Disk, Direct Attached
State : UP
Flag : PrefRestore
```

This example output is shortened; more flags may appear in actual output.

Removing AdvancedDisk storage server attributes

Use the `nbdevconfig` command to remove the following storage server attributes:

- Preferred restore server (`PrefRestore`)
- Required restore server (`ReqRestore`)
- Required duplication server (`ReqDuplicate`)

See “About AdvancedDisk preferred or required read servers” on page 16.

Attributes are added when you use the `nbdevconfig` command to configure a storage server.

See “Configuring an AdvancedDisk storage server” on page 27.

The following is the path to the `nbdevconfig` command:

- UNIX: `/usr/openv/netbackup/bin/admincmd`
- Windows: `install_path\NetBackup\bin\admincmd`

To remove AdvancedDisk storage server attributes

- Run the following command on the NetBackup master server or on a storage server:

```
nbdevconfig -changests -storage_server storage_server -stype AdvancedDisk -clearattribute attribute
```
Removing an AdvancedDisk storage server from disk pool access

Use the `nbdevconfig` command to remove a storage server so that it no longer can access a disk pool. If NetBackup jobs exist that use that storage server, you cannot remove the storage server.

**Warning:** If you remove the only storage server, data may be lost. NetBackup cannot access the disk pool and the backup images on the disk pool.

The following is the path to the `nbdevconfig` command:

- **UNIX:** `/usr/openv/netbackup/bin/admincmd`
- **Windows:** `install_path\NetBackup\bin\admincmd`

To remove an AdvancedDisk storage server from disk pool access

1. For every storage unit that specifies the storage server (media server) in **Use one of the following media servers**, clear the check box that specifies the media server. This step is not required if the storage unit is configured to use any available media server.

2. If only one storage server exists, change the state of all disk pools on the array to DOWN. To do so, use the following command:

   `nbdevconfig -changestate -stype AdvancedDisk -dp disk_pool_name -state DOWN`

3. Remove the storage server. The following is the command syntax:

   `nbdevconfig -changedp -stype AdvancedDisk -dp disk_pool_name -del_storage_servers storage_server`

Deleting an AdvancedDisk storage server

If you delete a storage server, NetBackup removes the storage server only from your configuration.

The media server is not deleted from your configuration. To delete the media server, use the **NetBackup nbemmcmd** command.

If a disk pool is configured from the disk volumes that the storage server manages, you cannot delete the storage server.

**Warning:** Do not delete a storage server if its storage contains unexpired NetBackup images. If you do, data loss may occur.
To delete an AdvancedDisk storage server

1. In the **NetBackup Administration Console**, expand **Media and Device Management > Credentials > Storage Server**.
2. On the **Edit** menu, select **Delete**.
3. Click **Yes** in the confirmation dialog box.

Managing AdvancedDisk disk pools

After you configure AdvancedDisk, you can perform various tasks to manage your AdvancedDisk disk pools.

See “Viewing AdvancedDisk disk pools” on page 76.
See “About changing the AdvancedDisk disk pool size” on page 76.
See “Adding volumes to an AdvancedDisk disk pool” on page 77.
See “Changing AdvancedDisk disk pool properties” on page 77.
See “Determining AdvancedDisk disk pool state” on page 79.
See “Changing AdvancedDisk disk pool state” on page 79.
See “Determining AdvancedDisk disk volume state” on page 79.
See “Changing AdvancedDisk disk volume state” on page 80.
See “Merging AdvancedDisk disk pools” on page 81.
See “Removing a volume from an AdvancedDisk disk pool” on page 81.
See “Inventorying a NetBackup disk pool” on page 82.
See “Deleting an AdvancedDisk disk pool” on page 83.

Viewing AdvancedDisk disk pools

Use the **NetBackup Administration Console** to view configured disk pools.

To view disk pools

- In the **NetBackup Administration Console** tree, in the left pane, select **Media and Device Management > Devices > Disk Pools**.
  
  The list appears in the right pane.

About changing the AdvancedDisk disk pool size

Two methods exist to change the size of a disk pool, as follows:
If you use a logical volume manager, you can use it to change the size of a disk volume by adding LUNs to it. If you do, you must inventory the disk pool so that NetBackup reads the new size of the pool. See “Inventorying a NetBackup disk pool” on page 82.

If you do not use a logical volume manager, you can change the size by adding or removing volumes from the disk pool. See “Adding volumes to an AdvancedDisk disk pool” on page 77. See “Removing a volume from an AdvancedDisk disk pool” on page 81.

Adding volumes to an AdvancedDisk disk pool

You can expand a disk pool’s capacity by adding disk volumes to the disk pool. The names of the new volumes must differ from the names of the volumes in the current disk pool.

The NetBackup storage units that use the disk pool use the additional storage capacity automatically. You do not have to change the storage units.

(By default, NetBackup automatically increases disk pool capacity if the capacity of the underlying disk volumes increases. Similarly, NetBackup decreases the capacity of a disk pool if the underlying disk volume capacity decreases.)

Table 4-1  Add volumes process for an AdvancedDisk disk pool

<table>
<thead>
<tr>
<th>Task</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a disk pool from the new disk volumes on the storage server.</td>
<td>See “Configuring an AdvancedDisk disk pool” on page 42.</td>
</tr>
<tr>
<td>Merge the disk pools.</td>
<td>When you merge the disk pools, specify the original disk pool as the primary one. NetBackup deletes the secondary disk pool after the merge. See “Merging AdvancedDisk disk pools” on page 81.</td>
</tr>
</tbody>
</table>

Changing AdvancedDisk disk pool properties

You can change the storage server for a disk pool and change the properties of a disk pool.

To add volumes to a disk pool, you must use a different procedure. See “Adding volumes to an AdvancedDisk disk pool” on page 77.
To change disk pool properties

1. In the **NetBackup Administration Console**, in the left pane, expand **Media and Device Management > Devices > Disk Pools**.

2. In the right pane, select the disk pool that you want to change.

3. Click **Edit > Change**.

4. In the **Change Disk Pool** dialog box, change storage servers or the properties.
   
   See “**AdvancedDisk disk pool properties**” on page 53.

5. Click **OK**.
Determining AdvancedDisk disk pool state

Disk pool state is UP or DOWN.

To determine AdvancedDisk disk pool state

1. In the NetBackup Administration Console, in the left pane, select Media and Device Management > Device Monitor.
2. Select the Disk Pools tab.
3. The state is displayed in the Status column.

Changing AdvancedDisk disk pool state

You can change the state of a NetBackup disk pool. Pool states are UP or DOWN.

To change the state to DOWN, the disk pool must not be busy. If backup jobs are assigned to the disk pool, the state change fails. Cancel the backup jobs or wait until the jobs complete.

To change AdvancedDisk disk pool state

1. In the NetBackup Administration Console, in the left pane, select Media and Device Management > Device Monitor.
2. Select the Disk Pools tab.
3. Select the disk pool.
4. Select either Actions > Up or Actions > Down.

Determining AdvancedDisk disk volume state

Use the NetBackup nbdevquery command to determine the state of the volumes in AdvancedDisk disk pools.

To determine AdvancedDisk disk volume state

- Display the state of the volumes in a disk pool by using the following command:

  UNIX: /usr/openv/netbackup/bin/admincmd/nbdevquery -listdv -U -stype server_type -dp disk_pool_name

  Windows: install_path\NetBackup\bin\admincmd\nbdevquery -listdv -U -stype server_type -dp disk_pool_name

The following items describe the arguments for the options:
For the server type, use one of the following types:

- **AdvancedDisk** for nonencrypted storage.
- **AdvancedDisk_crypt** for encrypted storage.

`-stype server_type` For the server type, use one of the following types:

- **AdvancedDisk** for nonencrypted storage.
- **AdvancedDisk_crypt** for encrypted storage.

`dp disk_pool_name` The name of the disk pool. To display the disk volumes in all disk pools of the specified type, omit the `-dp` option.

The command displays all of the volumes in the disk pool. The `state` is either **UP** or **DOWN**.

### Changing AdvancedDisk disk volume state

Use the NetBackup `nbdevconfig` command to change disk volume state. The state is **UP** or **DOWN**.

To change the state to **DOWN**, the disk pool in which the volume resides must not be busy. If backup jobs are assigned to the disk pool, the state change fails. Cancel the backup jobs or wait until the jobs complete.

NetBackup jobs still read from and write to a disk pool that has a downed volume, but the downed volume is unavailable.

**To change the AdvancedDisk disk volume state**

1. Determine the name of the disk volume.
   
   See “Determining AdvancedDisk disk volume state” on page 79.

2. Change the disk volume state. The following is the command syntax:

   **UNIX:** `/usr/openv/netbackup/bin/admincmd/nbdevconfig -changestate -stype server_type -dp disk_pool_name -dv vol_name -state state`

   **Windows:** `install_path\NetBackup\bin\admincmd\nbdevconfig -changestate -stype server_type -dp disk_pool_name -dv vol_name -state state`

The following items describe the arguments for the options:

- **-stype server_type** For the server type, use one of the following types:
  
  - **AdvancedDisk** for nonencrypted storage.
  - **AdvancedDisk_crypt** for encrypted storage.
The name of the disk pool.

```
disk_pool_name
```

The name of the disk volume.

```
-dv vol_name
```

Specify **UP** or **DOWN**. **RESET** sets the internal state to **UP**, sets committed_space to zero, and sets the precommitted space to zero.

```
-state state
```

### Merging AdvancedDisk disk pools

Use the NetBackup `nbdevconfig` command to merge existing disk pools.

NetBackup updates the catalog records to show the correct location of the backup images in those disk pools.

If the secondary disk pool is referenced by storage units, you must first delete those storage units.

The following is the path to the `nbdevconfig` command:

- **UNIX:** `/usr/openv/netbackup/bin/admincmd`
- **Windows:** `install_path\netbackup\bin\admincmd`

**To merge AdvancedDisk disk pools**

1. Change the state of each disk pool to **DOWN**.
   
   See “Changing AdvancedDisk disk pool state” on page 79.

   If backup jobs are assigned to a disk pool, the state change fails. Cancel the backup jobs or wait until the jobs complete.

2. Merge the disk pools. The following is the command syntax. The primary disk pool is the one you want to retain; `nbdevconfig` deletes the secondary disk pool after the merge.

   ```
   nbdevconfig -mergedps -stype AdvancedDisk -primarydp disk_pool_name -secondarydp disk_pool_name
   ```

3. Change the state of the primary disk pool to **UP**.
   
   See “Changing AdvancedDisk disk pool state” on page 79.

### Removing a volume from an AdvancedDisk disk pool

Use the `nbdevconfig` command to remove a volume from a disk pool. The following are the prerequisites:

- NetBackup image fragments cannot exist on the disk volume.
NetBackup jobs cannot be active on the disk volume. By default, NetBackup automatically decreases disk pool capacity if you remove a disk volume.

The following is the path to the `nbdevconfig` command:

- **UNIX**: `/usr/openv/netbackup/bin/admincmd`
- **Windows**: `install_path\NetBackup\bin\admincmd`

**To remove a volume from an AdvancedDisk disk pool**

1. Change the disk volume state to DOWN.
   
   See “Changing AdvancedDisk disk volume state” on page 80.

2. Change the disk pool state to DOWN.
   
   See “Changing AdvancedDisk disk pool state” on page 79.

3. Remove the volume by using the `nbdevconfig` command. The following is the command syntax:

   ```bash
   nbdevconfig -deletedv -stype AdvancedDisk -dp disk_pool_name -dv vol_name
   ```

4. Change the disk pool state to UP.
   
   See “Changing AdvancedDisk disk pool state” on page 79.

**Inventorying a NetBackup disk pool**

An inventory of a NetBackup disk pool reads the capacity of the disk volumes in the pool. An inventory operation lets you update NetBackup with the new capacity values if you do the following:

- Increase or decrease the size of the disk volumes in a disk pool.
- Add volumes to or remove volumes from a disk pool.

How you increase or decrease the underlying storage capacity depends on your storage implementation. You must complete that process before you inventory the disk pool.

**To inventory a NetBackup disk pool**

1. In the **NetBackup Administration Console**, select **Media and Device Management > Devices > Disk Pools**.

2. On the **Actions** menu, select **Inventory Disk Pools**.

3. In the **Inventory Disk Pool** dialog box, select the disk pool to inventory and then click **Start Inventory**.
To update the NetBackup catalog with the capacity values returned by the inventory, click **Update Configuration**.

To inventory another disk pool, go to step 3.

To exit, click **Close**.

### Deleting an AdvancedDisk disk pool

If you delete a disk pool, NetBackup removes it from your configuration.

If a disk pool is the storage destination of a storage unit, you must first delete the storage unit.

**Warning:** Do not delete a disk pool that contains unexpired NetBackup images; if you do, data loss may occur.

### To delete an AdvancedDisk disk pool

1. In the **NetBackup Administration Console**, in the left pane, select **Media and Device Management > Devices > Disk Pools**.
2. Select a disk pool
3. Click **Edit > Delete**.
4. In the **Delete Disk Pool** dialog box, verify that the disk pool is the one you want to delete and then click **OK**.

### About monitoring AdvancedDisk storage capacity and usage

Table 4-2 describes the ways that you can monitor storage capacity and usage.

<table>
<thead>
<tr>
<th>What</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The NetBackup Administration Console <strong>Disk Pools</strong> window</td>
<td>The <strong>Disk Pools</strong> window displays a value that was stored when NetBackup polled the disk pools. NetBackup polls every 5 minutes; therefore, the value may not be as current as the value that is displayed in the <strong>Storage Server</strong> window. To display the window, select <strong>Media and Device Management &gt; Devices &gt; Disk Pools</strong>.</td>
</tr>
</tbody>
</table>
Table 4-2  Monitor storage capacity and usage (continued)

<table>
<thead>
<tr>
<th>What</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The NetBackup Disk Pool status report</td>
<td>See “Viewing AdvancedDisk disk reports” on page 85.</td>
</tr>
<tr>
<td>NetBackup Administration Console <strong>Storage Server</strong> window</td>
<td>The storage server view displays real-time values. To display the window, select <strong>Media and Device Management &gt; Credentials &gt; Storage Servers</strong>.</td>
</tr>
<tr>
<td>The <code>nbdevquery</code> command</td>
<td>See “Displaying detailed AdvancedDisk storage usage information” on page 86.</td>
</tr>
</tbody>
</table>

The NetBackup OpsCenter also provides information about storage capacity and usage.

See the *NetBackup OpsCenter Administrator’s Guide*:

http://www.veritas.com/docs/DOC5332

### Monitoring NetBackup disk activity

You can monitor NetBackup disk-related activity and status by viewing the NetBackup log files.

Some NetBackup commands or processes write messages to their own log files. Other processes use Veritas unified log (VxUL) files. VxUL uses a standardized name and file format for log files. An originator ID (OID) identifies the process that writes the log messages.

**Table 4-3** shows the NetBackup logs for disk-related activity.

The messages that begin with a `sts_` prefix relate to the interaction with the storage vendor software plug-in. Most interaction occurs on the NetBackup media servers.

**Table 4-3**  NetBackup logs

<table>
<thead>
<tr>
<th>Activity</th>
<th>VxUL OID</th>
<th>Processes that use the ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backups and restores</td>
<td>N/A</td>
<td>Messages appear in the log files for the following processes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ The <code>bpbrm</code> backup and restore manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ The <code>bpdbm</code> database manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ The <code>bpdm</code> disk manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ The <code>bptm</code> tape manager for I/O operations</td>
</tr>
</tbody>
</table>
Table 4-3  NetBackup logs *(continued)*

<table>
<thead>
<tr>
<th>Activity</th>
<th>VxUL OID</th>
<th>Processes that use the ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backups and restores</td>
<td>117</td>
<td>The nbjm job manager.</td>
</tr>
<tr>
<td>Device configuration</td>
<td>111</td>
<td>The nbemm process.</td>
</tr>
<tr>
<td>Device configuration</td>
<td>178</td>
<td>The Disk Service Manager process that runs in the Enterprise Media Manager (EMM) process.</td>
</tr>
<tr>
<td>Device configuration</td>
<td>202</td>
<td>The Storage Server Interface process that runs in the Remote Manager and Monitor Service.</td>
</tr>
<tr>
<td></td>
<td>230</td>
<td>The Remote Disk Service Manager interface (RDSM) that runs in the Remote Manager and Monitor Service.</td>
</tr>
</tbody>
</table>

To view and manage VxUL log files, you must use NetBackup log commands. Information about how to use and manage logs on NetBackup servers is available. See the *NetBackup Logging Reference Guide*: http://www.veritas.com/docs/DOC5332

**Viewing AdvancedDisk disk reports**

The NetBackup disk reports include information about the disk pools, disk storage units, disk logs, images that are stored on disk media, and storage capacity. *Table 4-4* describes the disk reports available.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Images on Disk</td>
<td>The Images on Disk report generates the image list present on the disk storage units that are connected to the media server. The report is a subset of the Images on Media report; it shows only disk-specific columns.</td>
</tr>
<tr>
<td></td>
<td>The report provides a summary of the storage unit contents. If a disk becomes bad or if a media server crashes, this report can let you know what data is lost.</td>
</tr>
</tbody>
</table>
Table 4-4  Disk reports (continued)

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk Logs</td>
<td>The Disk Logs report displays the media errors or the informational messages that are recorded in the NetBackup error catalog. The report is a subset of the Media Logs report; it shows only disk-specific columns.</td>
</tr>
<tr>
<td>Disk Storage Unit Status</td>
<td>The Disk Storage Unit Status report displays the state of disk storage units in the current NetBackup configuration. For disk pool capacity, see the disk pools window in Media and Device Management &gt; Devices &gt; Disk Pools. Multiple storage units can point to the same disk pool. When the report query is by storage unit, the report counts the capacity of disk pool storage multiple times.</td>
</tr>
<tr>
<td>Disk Pool Status</td>
<td>The Disk Pool Status report displays the state of disk pool storage units. This report displays only when a license that enables NetBackup disk features is installed.</td>
</tr>
</tbody>
</table>

To view disk reports

1. In the NetBackup Administration Console, in the left pane, expand NetBackup Management > Reports > Disk Reports.
2. Select the name of a disk report.
3. In the right pane, select the report settings.

**Displaying detailed AdvancedDisk storage usage information**

The NetBackup nbdevquery command lets you display detailed information about the storage use of disk pools and disk volumes.
To determine the disk volume storage usage

1. Determine the names of all AdvancedDisk disk pools in your NetBackup domain:

   `nbdevquery -listdp -stype AdvancedDisk`

   V7.5 DiskPool-AdvDisk 1 201.00 201.00 3 98 80 -1 adv_server.example.com

2. Determine disk volume names in the AdvancedDisk disk pool:

   `nbdevquery -listdv -stype AdvancedDisk -dp disk_pool_name`

   Replace `disk_pool_name` with the name of the disk pool for which you want to determine the volume names.

   The following is example output:

   V7.5 DiskPool-AdvDisk AdvancedDisk /advdisk_disc1 @aaaak 0.00 0.00 100 1 0 1 0 0 14
   V7.5 DiskPool-AdvDisk AdvancedDisk /advdisk_disc2 @aaaal 200.00 79.75 60 1 0 1 0 0 14
   V7.5 DiskPool-AdvDisk AdvancedDisk /advdisk_disc3 @aaaam 1.00 1.00 0 1 0 1 0 0 14

3. Display the usage information for a specific AdvancedDisk disk volume:

   `nbdevquery -listdv -stype AdvancedDisk -dp disk_pool_name -dv disk_volume_name -D`

   Replace `disk_pool_name` with the name of the disk pool for which you want to determine the volume names. Replace `disk_volume_name` with the name of the disk volume for which you want to display usage information.

   The output from the command includes the following fields:

   ```
   total_capacity : 214748364800
   total_phys_capacity : 214748364800
   free_space : 85625798656
   free_phys_space : 85625798656
   potential_free_space: 0
   committed_space : 0
   precommitted_space : 0
   ```

   See “NetBackup disk volume capacity and usage reference” on page 87.

NetBackup disk volume capacity and usage reference

NetBackup determines the space available for backups on a volume by using the following formula:

Available space equals `free_space plus potential_free_space minus committed_space`.
The `potential_free_space` value is used only for a disk volume that is capacity managed. A disk volume is capacity managed when its disk pool is capacity managed. A disk pool is capacity managed when it is a destination in a storage lifecycle policy and the `Retention Type` is `Capacity managed`.

Table 4-5 describes the capacity values that NetBackup uses for space calculations.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>total_capacity</code></td>
<td>The total size of the disk. This value is derived from the file system and is updated at 1-minute intervals.</td>
</tr>
<tr>
<td><code>total_phys_capacity</code></td>
<td>For the purposes of AdvancedDisk, <code>total_capacity</code> and <code>total_phys_capacity</code> should have the same values.</td>
</tr>
<tr>
<td><code>free_space</code></td>
<td>The amount of free space on the disk. This value is derived from the file system and is updated at 1-minute intervals.</td>
</tr>
<tr>
<td><code>free_phys_space</code></td>
<td>For the purposes of AdvancedDisk, <code>free_space</code> and <code>free_phys_space</code> should have the same values.</td>
</tr>
<tr>
<td><code>potential_free_space</code></td>
<td>The sum of all of the fragments on the disk that NetBackup duplicated as part of a storage lifecycle policy and that are eligible for expiration. A fragment becomes eligible for expiration when it has been duplicated successfully. NetBackup calculates <code>potential_free_space</code> at the end of duplication sessions and expiration sessions. The <code>potential_free_space</code> value may become stale between computations. However, the next computation provides an accurate value.</td>
</tr>
</tbody>
</table>
| `committed_space`          | The estimated size of all of the jobs-in-progress that write to the volume, based on the following:
  - For an existing backup, NetBackup uses the size of the most recent backup plus 20%.
  - For a new backup (including user backups), NetBackup uses the capacity of the disk volume over the high-water mark. For example, on a 2-TB volume that has a 98% high-water mark, NetBackup uses 40 GBs.
  - For duplication jobs, NetBackup uses the size of the source image. |
Table 4-5  Disk capacity values (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>precommitted_space</td>
<td>The precommitted_space is a helper value for committed_space. NetBackup decrements the value while a backup job runs. Each time NetBackup updates the capacity and free space information, NetBackup updates the value of committed_space to the current value of precommitted_space. This process ensures that all capacity-related values are updated at the same time to provide the most accurate usage description for the disk volume.</td>
</tr>
</tbody>
</table>

Displaying KMS key information for AdvancedDisk encryption

You can use the nbkmsutil command to list the following information about the key groups and the key records:

- **Key groups**
  See To display KMS key group information.

- **Keys**
  See To display KMS key information.

**Note:** Veritas recommends that you keep a record key information. The key tag that is listed in the output is necessary if you need to recover keys.
To display KMS key group information

- To list all of the key groups, use the `nbkmsutil` with the `-listkgs` option. The following is the command format:

  UNIX: `/usr/openv/netbackup/bin/admincmd/nbkmsutil -listkgs`

  Windows: `install_path\Veritas\NetBackup\bin\admincmd\nbkmsutil -listkgs`

The following is example output on UNIX hosted storage. On Windows, the volume name is not used.

- Key Group Name: `AdvDiskServer1.example.com:AdvDisk_Volume`
- Supported Cipher: `AES_256`
- Number of Keys: `1`
- Has Active Key: `Yes`
- Creation Time: `Tues Jan 01 01:00:00 2013`
- Last Modification Time: `Tues Jan 01 01:00:00 2013`
- Description: `-`
To display KMS key information

To list all of the keys that belong to a key group name, use the `nbkmsutil` with the `-listkgs` and `-kgname` options. The following is the command format:

**UNIX:**
```
/usr/openv/netbackup/bin/admincmd/nbkmsutil -listkeys -kgname AdvDiskServer1.example.com:AdvDisk_Volume
```

**Windows:**
```
install_path\Veritas\NetBackup\bin\admincmd\nbkmsutil -listkeys -kgname AdvDiskServer1.example.com:
```

The following is example output on UNIX hosted storage. On Windows, the volume name is not used.

Key Group Name : AdvDiskServer1.example.com:AdvDisk_Volume
Supported Cipher : AES_256
Number of Keys : 1
Has Active Key : Yes
Description : -

Key Tag : 867d710aa7f4c64dcdd2cec...cced0c831c1812c510acd05
Key Name : dp-key
Current State : ACTIVE
Creation Time : Tues Jan 01 01:00:00 2013
Last Modification Time: Tues Jan 01 01:00:00 2013
Description : -

Number of Keys: 1
About unified logging

Unified logging and legacy logging are the two forms of debug logging used in NetBackup. All NetBackup processes use one of these forms of logging. Server processes and client processes use unified logging.

Unified logging creates log file names and messages in a standardized format. These logging files cannot be easily viewed with a text editor. They are in binary format and some of the information is contained in an associated resource file. Only the `vxlogview` command can assemble and display the log information correctly.

Unlike legacy logging, unified logging does not require that you create logging subdirectories. Log files for originator IDs are written to a subdirectory with the name specified in the log configuration file. All unified logs are written to subdirectories in the following directory:

Windows: `install_path\NetBackup\logs`

UNIX: `/usr/openv/logs`
You can access logging controls in the **NetBackup Administration Console**. In the left pane, expand **NetBackup Management > Host Properties > Master Servers** or **Media Servers**. Double-click the server you want to change. In the left pane of the dialog box, click **Logging**.

You can also manage unified logging by using the following commands:

- `vxlogcfg`: Modifies the unified logging configuration settings.
- `vxlogmgr`: Manages the log files that the products that support unified logging generate.
- `vxlogview`: Displays the logs that unified logging generates.

See “Examples of using `vxlogview` to view unified logs” on page 94.

These commands are located in the following directory:

Windows: `install_path\NetBackup\bin`

UNIX: `/usr/openv/netbackup/bin`

See the **NetBackup Commands Reference Guide** for a complete description about these commands.

More information about legacy logging is available.

See “About legacy logging” on page 95.

### About using the `vxlogview` command to view unified logs

Use the `vxlogview` command to view the logs that unified logging creates. These logs are stored in the following directory:

UNIX: `/usr/openv/logs`

Windows: `install_path\NetBackup\logs`

Unlike the files that are written in legacy logging, unified logging files cannot be easily viewed with a text editor. The unified logging files are in binary format, and some of the information is contained in an associated resource file. Only the `vxlogview` command can assemble and display the log information correctly.

You can use `vxlogview` to view NetBackup log files as well as PBX log files.

To view PBX logs using the `vxlogview` command, do the following:
- Ensure that you are an authorized user. For UNIX and Linux, you must have root privileges. For Windows, you must have administrator privileges.
- To specify the PBX product ID, enter -p 50936 as a parameter on the `vxlogview` command line.

`vxlogview` searches all the files, which can be a slow process. Refer to the following topic for an example of how to display results faster by restricting the search to the files of a specific process.

### Examples of using vxlogview to view unified logs

The following examples demonstrate how to use the `vxlogview` command to view unified logs.

#### Table 5-1  Example uses of the vxlogview command

<table>
<thead>
<tr>
<th>Item</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display all the attributes of the log messages</td>
<td><code>vxlogview -p 51216 -d all</code></td>
</tr>
</tbody>
</table>
| Display specific attributes of the log messages           | Display the log messages for NetBackup (51216) that show only the date, time, message type, and message text:  
                                                             `vxlogview --prodid 51216 --display D,T,m,x` |
| Display the latest log messages                          | Display the log messages for originator 116 (nbpem) that were issued during the last 20 minutes. Note that you can specify -o nbpem instead of -o 116:  
                                                             `# vxlogview -o nbpem -t 00:20:00` |
| Display the log messages from a specific time period     | Display the log messages for nbpem that were issued during the specified time period:  
                                                             `# vxlogview -o nbpem -b "05/03/15 06:51:48 AM" -e "05/03/15 06:52:48 AM"` |
Table 5-1  Example uses of the vxlogview command (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display results faster</td>
<td>You can use the -i option to specify an originator for a process:</td>
</tr>
<tr>
<td></td>
<td># vxlogview -i nbpem</td>
</tr>
<tr>
<td></td>
<td>The vxlogview -i option searches only the log files that the specified process (nbpem) creates. By limiting the log files that it has to search, vxlogview returns a result faster. By comparison, the vxlogview -o option searches all unified log files for the messages that the specified process has logged.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you use the -i option with a process that is not a service, vxlogview returns the message &quot;No log files found.&quot; A process that is not a service has no originator ID in the file name. In this case, use the -o option instead of the -i option.</td>
</tr>
<tr>
<td></td>
<td>The -i option displays entries for all OIDs that are part of that process including libraries (137, 156, 309, etc.).</td>
</tr>
<tr>
<td>Search for a job ID</td>
<td>You can search the logs for a particular job ID:</td>
</tr>
<tr>
<td></td>
<td># vxlogview -i nbpem</td>
</tr>
<tr>
<td></td>
<td>The jobid= search key should contain no spaces and must be lowercase.</td>
</tr>
<tr>
<td></td>
<td>When searching for a job ID, you can use any vxlogview command option. This example uses the -i option with the name of the process (nbpem). The command returns only the log entries that contain the job ID. It misses related entries for the job that do not explicitly contain the jobid=job_ID.</td>
</tr>
</tbody>
</table>

See the *NetBackup Commands Reference Guide* for a complete description of the vxlogview command. The guide is available through the following URL:

http://www.veritas.com/docs/DOC5332

### About legacy logging

Legacy logging and unified logging are the two forms of debug logging used in NetBackup. All NetBackup processes use either unified logging or legacy logging.

See “About unified logging” on page 92.
In legacy debug logging, each process creates log files of debug activity in its own logging directory. The NetBackup legacy debug log directories are located in the following directories:

Windows

\install_path\NetBackup\logs
\install_path\Volmgr\debug

UNIX

/usr/openv/netbackup/logs
/usr/openv/volmgr/debug

These top-level directories can contain a directory for each NetBackup process that uses legacy logging. By default, NetBackup creates only a subset of all of the possible log directories. For example, the following directories are created by default on UNIX servers:

- nhfp
- nbliveup
- nblogadm
- user_ops

To enable logging for all of the NetBackup processes that use legacy logging, you must create the log file directories that do not already exist, unless you use the Logging Assistant. For more information about the Logging Assistant, see the NetBackup Administrator's Guide, Volume I. The guide is available at the following location:

http://www.veritas.com/docs/DOC5332

You can use the following batch files to create all of the debug log directories at once:

- Windows: \install_path\NetBackup\Logs\mklogdir.bat
- UNIX: /usr/openv/netbackup/logs/mklogdir

See the NetBackup Commands Reference Guide for a complete description about the mklogdir command. The guide is available at the following location:

http://www.veritas.com/docs/DOC5332

After the directories are created, NetBackup creates log files in the directory that is associated with each process. A debug log file is created when the process begins. Each log file grows to a certain size before the NetBackup process closes it and creates a new log file.
To enable debug logging for the NetBackup Status Collection Daemon (vmscd), create the following directory before you start nbemm.

Windows  
`install_path\Volmgr\debug\vmscd\`

UNIX  
`/usr/openv/volmgr/debug/vmscd`

As an alternative, you can restart vmscd after creating the directory.

Creating NetBackup log file directories for AdvancedDisk

Before you configure your NetBackup feature, create the directories into which the NetBackup commands write log files. Create the directories on the master server and on each media server that you use for your feature. The log files reside in the following directories:

- UNIX: `/usr/openv/netbackup/logs/`
- Windows: `install_path\NetBackup\logs\`

More information about NetBackup logging is available in the *NetBackup Logging Reference Guide*, available through the following URL:

http://www.veritas.com/docs/DOC5332

To create log directories for NetBackup commands

- Depending on the operating system, run one of the following scripts:
  
  UNIX: `/usr/openv/netbackup/logs/mklogdir`
  
  Windows: `install_path\NetBackup\logs\mklogdir.bat`

To create the tpconfig command log directory

- Depending on the operating system, create the debug directory and the tpcommand directory (by default, the debug directory and the tpcommand directory do not exist). The pathnames of the directories are as follows:
  
  UNIX: `/usr/openv/volmgr/debug/tpcommand`
  
  Windows: `install_path\Veritas\Volmgr\debug\tpcommand`

NetBackup AdvancedDisk log files

You can monitor NetBackup AdvancedDisk activity and status by viewing the NetBackup log files.
Some NetBackup commands or processes write messages to their own log files. For those commands and processes, the log directories must exist so that the utility can write log messages.

See “Creating NetBackup log file directories for AdvancedDisk” on page 97.

Other processes use Veritas unified log (VxUL) files. Each process has a corresponding VxUL originator ID. VxUL uses a standardized name and file format for log files. To view VxUL log files, you must use the NetBackup vxlogview command.

More information about how to view and manage VxUL log files is available. See the NetBackup Logging Reference Guide:

http://www.veritas.com/docs/DOC5332

The following are the component identifiers for log messages:

- An sts_ prefix relates to the interaction with the plug-in that writes to and reads from the storage.
- An encrypt prefix relates to interaction with the encryption plug-in.
- A KMSCLIB prefix relates to interaction with the NetBackup Key Management Service.

Most interaction occurs on the NetBackup media servers. Therefore, the log files on the media servers that you use for disk operations are of most interest.

---

**Warning:** The higher the log level, the greater the affect on NetBackup performance. Use a log level of 5 (the highest) only when directed to do so by a Veritas representative. A log level of 5 is for troubleshooting only.

Specify the NetBackup log levels in the **Logging** host properties on the NetBackup master server. The log levels for some processes specific to certain options are set in configuration files as described in Table 5-2.

---

Table 5-2 describes the logs.
Table 5-2 NetBackup logs

<table>
<thead>
<tr>
<th>Activity</th>
<th>OID</th>
<th>Processes</th>
</tr>
</thead>
</table>
| Backups and restores                          | N/A | Messages appear in the log files for the following processes:  
|                                               |     | ■ The bpbrm backup and restore manager.  
|                                               |     | ■ The bpdbm database manager.  
|                                               |     | ■ The bpdm disk manager.  
|                                               |     | ■ The bptm tape manager for I/O operations.  
|                                               |     | The log files reside in the following directories:  
|                                               |     | ■ UNIX: /usr/openv/netbackup/logs/  
|                                               |     | ■ Windows:install_path\NetBackup\logs\ |
| Backups and restores                          | 117 | The nbjm Job Manager.                                                                                                                                 |
| Image cleanup, verification, import, and duplication | N/A | The bpdbm database manager log files.  
|                                               |     | The log files reside in the following directories:  
|                                               |     | ■ UNIX: /usr/openv/netbackup/logs/bpdbm  
|                                               |     | ■ Windows:install_path\NetBackup\logs\bpdbm |
| Device configuration                          | 111 | The nbemm process.                                                                                                                                 |
| Device configuration                          | 178 | The Disk Service Manager process that runs in the Enterprise Media Manager (EMM) process.                                                                 |
| Device configuration                          | 202 | The Storage Server Interface process that runs in the Remote Manager and Monitor Service. RMMS runs on media servers.                       |
| Device configuration                          | 230 | The Remote Disk Service Manager interface (RDSM) that runs in the Remote Manager and Monitor Service. RMMS runs on media servers.           |

AdvancedDisk troubleshooting

The following may help you troubleshoot AdvancedDisk:
### AdvancedDisk troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unable to access storage</strong></td>
<td>If NetBackup cannot access the storage, one possible cause is that the storage server was created with the incorrect <code>nbdevconfig</code> storage type (<code>-st</code>) value. An AdvancedDisk storage server <code>-st</code> value is 5 (formatted disk, directly attached); values other than 5 are incorrect. More procedural information is available about resolving this problem. See &quot;Resolving an incorrect storage type problem&quot; on page 100.</td>
</tr>
<tr>
<td><strong>Multiple storage servers on Windows</strong></td>
<td>AdvancedDisk does not support Common Internet File System (CIFS). If you try to configure multiple storage servers, NetBackup returns the following message: DSM does not support to use multiple Windows Storage Servers for server type: AdvancedDisk.</td>
</tr>
<tr>
<td><strong>Volume state changes to DOWN when volume is unmounted</strong></td>
<td>If a volume becomes unmounted, NetBackup changes the volume state to DOWN. NetBackup jobs that require that volume fail. To change the volume state to UP, mount the file system</td>
</tr>
<tr>
<td><strong>Disk failure - AdvancedDisk</strong></td>
<td>If recovery mechanisms do not protect a disk that fails, the backup images on that disk are lost. Operating system read and write errors may occur for the volume that represents the disk. NetBackup cannot use that volume because of the errors, and NetBackup jobs may fail. To prevent NetBackup from trying to read from or write to the disk, you must change the volume state to DOWN in NetBackup. If the volume represents other disks that still function, those disks are not available because the volume state is DOWN. You may be able to read from the volume by mounting it manually. If so, you may be able to recover image fragments from any disks that did not fail. If you replace a failed disk, you can use the same mount point for the replacement disk. Change the volume state to UP, and NetBackup uses that volume again. Any valid backup images on that volume are available for restores.</td>
</tr>
</tbody>
</table>

### Resolving an incorrect storage type problem

First determine the storage server value to verify that the storage server was created with the incorrect `nbdevconfig` storage type value. Then proceed to resolving the problem if necessary.
To determine the storage server value

- Invoke the following command on the master server or a media server that functions as a storage server:

  The following output shows an incorrect value for AdvancedDisk:

  Storage Server : halo
  Storage Server Type : AdvancedDisk
  Storage Type : Formatted Disk, Network Attached

To resolve an incorrect storage type problem

1. Delete all disk pools that use the storage server.
2. Delete the storage server.
3. Reconfigure the storage server.
4. Recreate the disk pools.
5. If necessary, specify the new disk pools in the storage units.

   If you recreated the disk pools with the same names as the ones you deleted, this step is not necessary.

See “AdvancedDisk troubleshooting” on page 99.
A
Active secondary operations 64
AdvancedDisk
  CIFS requirements 13
  license key for 9
  load balancing 8
  NFS requirements 14
  volume managers 40
AdvancedDisk disk storage units 14
B
Backup
  operation 63
BasicDisk storage units
  credentials for CIFS 14
bpcd client process 14
bpinetd client process 14
C
CIFS
  configuring for AdvancedDisk encryption 41
  credentials for disk storage units 14
  for AdvancedDisk 34, 47
  for AdvancedDisk encryption 41–42
D
data classifications
  in storage lifecycle policies 60, 63
disk pools
  changing the state 79
Duplication
  optimized 64
E
encryption
  see also 19
F
FQDN or IP Address property in Resilient Network
  host properties 68
J
job ID search in unified logs 95
L
legacy logging 96
  directories 96
  locations 96
license key
  for AdvancedDisk 9
logging
  legacy 96
M
Media Server Deduplication Pool
  changing the state 79
  Media server storage unit setting 57
mklogdir.bat 96
N
NBRMMS (NetBackup Remote Management and
  Monitor Service) 14
NDMP
  storage units 64
O
OpenStorage
  optimized duplication 64
  OpenStorage Disk Option 59
P
policies
  changing properties 65
  creating 65
Postponed secondary operations 64
Priority for secondary operations 64
Replication Director
Policy Configuration Wizard, unsupported 65
Resiliency property in Resilient Network host properties 68
Resilient connection
Resilient Network host properties 66
Resilient Network host properties 66
FQDN or IP Address property in 68
Resiliency property in 68

server
NetBackupdebug logs 96
snapshots
operation type 63
Status Collection Daemon 97
storage lifecycle policies
Active secondary operations 64
best practices document 60
Data classification setting 63
hierarchy 61
operations 60
Postponed secondary operations 64
Priority for secondary operations 63
Storage lifecycle policy name 63
utility 59
Validate Across Backup Policies button 64
storage unit groups
and storage lifecycle polices 64

troubleshooting
AdvancedDisk disk failure 100
AdvancedDisk volume state changes to DOWN when volume is unmounted 100
multiple AdvancedDisk storage servers on Windows 100
unable to access AdvancedDisk storage 100

UNC path
with CIFS and AdvancedDisk storage units 15
with CIFS and BasicDisk storage units 15
unified logging 92
format of files 93
location 92

Validate Across Backup Policies button in SLP 64
Validation Report tab 64
vmscd 97
vmscd directory 97
volume managers with AdvancedDisk 40
vxlogview command 93
with job ID option 95

wizards
Policy Configuration 65